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 SAFETY INFORMATION 
For your safety and protection, read this entire user manual before  you attempt to use the 
Broadband Global Area Network (BGAN) Satellite Terminal. In particular, read this safety section 
carefully. Keep this safety information where you can refer to it if necessary. 

WARNING SYMBOLS USED IN THIS MANUAL 

 

WARNING 
Potential radio Frequency (RF) hazard. Where you see this alert symbol and 
WARNING heading, strictly follow the warning instructions to avoid injury to 
eyes or other personal injury. 

 

WARNING 
Where you see this alert symbol and WARNING heading, strictly follow the 
warning instructions to avoid personal injury. 

 

DANGER 
Electric shock hazard: Where you see this alert symbol and DANGER heading, 
strictly follow the warning instructions to avoid electric shock injury or death. 

 

WARNINGS FOR SATELLITE TERMINAL 

 

DO NOT STAND IN FRONT OF THE ANTENNA 
This device emits radio frequency energy. To avoid injury, do not place head or 
other body parts in front of the satellite antenna when system is operational. 
Maintain a distance of two meters or more from the front of the Satellite 
Terminal antenna. 

 

PROPERLY GROUND THE EXTERNAL ANTENNA 
Failure to properly ground the optional external antenna may result in severe 
personal injury or death. Do not attempt to ground the optional external 
antenna unless you have the skills to do so in accordance with local electrical 
codes. 

 

DO NOT OPERATE DURING ELECTRICAL STORMS 
Operation of the Satellite Terminal during electrical storms may result in severe 
personal injury or death. Disconnect the Terminal from the computer and store 
the unit indoors if lightning is anticipated in the area of operation. 
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GENERAL 
Handle your Satellite Terminal with care. The enclosure is weather resistant per 
IEC 60529 IP55; however, do not submerge the unit or expose it to severe rain 
storms. Avoid exposing your Satellite Terminal to extreme hot or cold 
temperatures outside the range -25ºC to +60ºC. 

Avoid placing the Terminal close to cigarettes, open flames or any source of 
heat. 

Changes or modifications to the Terminal not expressly approved by Hughes 
Network Systems could void your authority to operate this equipment. 

Only use a soft damp cloth to clean the Terminal. 

To avoid impaired Terminal performance, please ensure the unit’s antenna is 
not damaged or covered with foreign material like paint or labeling. 

When inserting the USIM/SIM, do not bend it or damage the contacts in any 
way. When connecting the interface cables, do not use excessive force. 

 

IN THE VICINITY OF BLASTING WORK AND IN EXPLOSIVE ENVIRONMENTS 
Never use the Satellite Terminal where blasting work is in progress. Observe all 
restrictions and follow any regulations or rules. Areas with a potentially 
explosive environment are often, but not always, clearly marked. Do not use 
the Terminal while at a petrol filling station. Do not use near fuel or chemicals. 

 

QUALIFIED SERVICE 
Do not attempt to disassemble your Satellite Terminal. The unit does not 
contain consumer-serviceable components. Only qualified service personnel 
may install or repair equipment. 

 

BATTERIES AND ACCESSORIES 
Use approved batteries (HNS P/N 3500065-0001) and accessories only. Use of 
non-approved accessories may result in loss of performance, damage to the 
Satellite Terminal, fire, electric shock or injury.  

The AC power adapter (HNS P/N 3500068-0001) is for indoor use only. It has an 
indoor operating temperature range of 0ºC to +40ºC and provides an output 
voltage of 20 VDC.  

The storage capacity of the battery decreases when operated. 

The terminal will only charge the battery when the temperature is within the 
range of 0 to 45°C. 

 

CONNECTING DEVICES 
Never connect incompatible devices to the Satellite Terminal. When 
connecting the Satellite Terminal to any other device, read the device’s User 
Manual for detailed safety instructions. 
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PACEMAKERS 
The various brands and models of cardiac pacemakers available exhibit a 
wide range of immunity levels to radio signals. Therefore, people who wear a 
cardiac pacemaker and who want to use a Satellite Terminal should seek the 
advice of their cardiologist. If, as a pacemaker user, you are still concerned 
about interaction with the Satellite Terminal, we suggest you follow these 
guidelines: 

n Maintain a distance of 30 cm between the Terminal and your pacemaker; 

n Maintain a distance of two meters from the front of the unit’s antenna; 

n Refer to your pacemaker product literature for information on your 
particular device. 

If you have any reason to suspect that interference is taking place, turn off 
your Satellite Terminal immediately! 

 

HEARING AIDS 
Most new models of hearing aids are immune to radio frequency interference 
from Satellite Terminals that are more than 2 meters away. Many types of older 
hearing aids may be susceptible to interference, making it very difficult to use 
them near a Terminal. Should interference be experienced, maintain 
additional separation between you and the Satellite Terminal. 
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 INTRODUCTION 
 

ABOUT THIS PRODUCT 
The Hughes Network System (HNS) 9201 Broadband Satellite Terminal and WLAN Access Point is 
your gateway to global communication. The 9201 allows you to simultaneously send and 
receive IP packet and circuit-switched data via Universal Serial Bus (USB), Ethernet, Integrated 
Services Digital Network (ISDN), and WLAN interfaces over the Inmarsat BGAN satellite network.  

The unit offers you the following features and benefits: 

n 492 Kbps data (transmit and receive) 

n Speech (4Kbps) 

n ISDN voice (3.1KHz audio) 

n ISDN data (64Kbps) 

n WLAN access point 

n Multi-user capability for sharing a single unit 

n Selectable Quality-of-Service (QoS) 

n Full IP compatibility for Email, file transfer (FTP), browsing, VPN, etc. 

n Cost-effective “always-on” access – charges only for data sent and received 

n UMTS IP-based services 

n WLAN, FCC, CE, and GMPCS certified 

n Subscriber Identification Module (SIM) card security 

n LED indicators and audio pointing aids for obtaining an Inmarsat satellite signal 

n GPS and WLAN status LEDs 
 

The unit is easy to install and connects in minutes. It is built for use in fixed, semi-fixed, and 
portable environments. The rugged design allows the unit to be installed outside in extreme 
weather conditions for extended periods of time, and the small size and weight lets you easily 
move it from site to site. 

The Satellite Terminal carries a warranty for 12 months from the date of sale. Contact your 
Service Provider if you have questions about the warranty, or need to return the terminal for 
repair. 

In this document, the following names and abbreviations are used to identify the Satellite 
Terminal and your computer. 

Term Definition 

Terminal BGAN Satellite Terminal. 

UT User Terminal; BGAN Satellite Terminal. 

TE Terminal Equipment, e.g. your computer. 
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ABOUT THIS USER GUIDE 
This user guide contains the most up-to-date information available on this product, on the date it 
was generated, and is included as part of the LaunchPad software under the Help tab. 

 

COVERAGE AREA 

 

The map shows the global coverage that will be provided by the BGAN satellites as of the dates 
on the tabs in the screen shot. You are able to access one of the BGAN satellites by pointing the 
terminal to that satellite. In addition to the satellites, the BGAN system includes infrastructure 
equipment on the ground, that connects to telephone networks and the internet. By accessing 
the satellites, your terminal can then connect to telephone and data networks. 
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PACKAGE CONTENTS 
 

When you unpack the Satellite Terminal package, you 
will find the following: 

n BGAN 9201 Broadband Satellite Terminal and WLAN 
Access Point 

n Rechargeable lithium ion battery pack 

n AC power adapter and cable (100 – 240 VAC) 

n Travel adaptor 

n USB cable 

n Ethernet cable 

n ISDN cable 

n Installation CD 
 

The following are accessories not included in the package: 

n Extra standard lithium ion battery pack 

n Extended lithium ion battery pack 

n Standard AC power adapter (100 – 240 VAC) 

n Fix Mount Kit 

n DC (vehicular) power adapter 

n External passive antenna 

n 2-4 wire ISDN terminal adapter 

n Security Covers for Fix Mount Kit 
 

Your Service Provider will supply you with a Subscriber Identification Module (SIM) and its PIN, 
and Satellite Terminal configuration instructions – you will need these to access the network.   
Note:  The SIM card will also have four (4) MSISDN numbers associated with it for various ISDN 
services: 

4K Voice 

3.1KHz Audio/Fax 

64K UDI data 

56K RDI data 
 

MINIMUM SYSTEM REQUIREMENTS 
These are the minimum computer system requirements for successful interface with the Satellite 
Terminal: 

n CD-ROM (for installation CD) 

n Internet Browser:  Microsoft Internet Explorer version 5.5 or later; Netscape Communicator 
version 7.0 or later (Java must be active). 

n PC Support for at least one of these interfaces – USB, Ethernet, ISDN or WLAN (802.11b or 
b/g). 
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n Intel Pentium III CPU, or equivalent. 

n 100 MB of free hard disk space. 

n 128 MB of RAM. 
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 GETTING STARTED 
 

INTRODUCTION TO GETTING STARTED 
This guide is the simplest and quickest way to connect to the BGAN network. If you are a first 
time user, you will be guided through the procedure for powering up your terminal, obtaining a 
GPS fix, connecting your computer to the terminal and registering with the BGAN network. You 
are then ready to start using voice and broadband services. 

SETTING UP YOUR TERMINAL 
To set up your terminal, you must: 

n Install the USIM/SIM Card and the Battery supplied with your terminal 

n Put the Battery on Charge. 

To set up the terminal: 

1. Position the terminal so that the battery door is facing you.  

2. Open the battery door. (If you have already installed the battery, release and then remove 
it.) 

 

3. Push the button on the left-hand side of the USIM/SIM card holder. This releases the holder 
from its slot. 
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4. Install the USIM/SIM card in the card holder making sure it is snapped into place. 

 

5. With the card in place, orient the holder with the card’s gold contacts facing down. Place 
the holder back in its slot in the BGAN terminal. 

 

6. Put the battery into its slot in the BGAN terminal and lock it in place. Close and lock the 
battery door. 
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PUT THE BATTERY ON CHARGE 

To charge the battery, connect the AC power adapter to the terminal and to an external power 
source. The temperature of the battery must be within 0°C to 45°C for charging to take place 
successfully. 

USING THE AC POWER ADAPTER 

The AC power adapter is for indoor use only. It has an indoor operating temperature range of 
0ºC to 40ºC and provides an output voltage of 20 VDC. 

To power the terminal using the AC power adapter: 

1. Remove the power adapter from the terminal box.  

2. Insert the power adapter output connector to the DC Power Input Jack on the back of the 
terminal, as shown below: 

 

3. Plug the AC Power Cable into a suitable AC power outlet, and charge the battery for three 
hours. If the AC Power cable does not fit into your power outlet, use the travel adapter. 

þ 
Note 

You can operate the Satellite Terminal while the battery is charging. 

 

 

 

You are now ready to install the BGAN LaunchPad Software. 
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INSTALLING BGAN LAUNCH PAD 
As a first step, Inmarsat recommends that you install BGAN LaunchPad on your computer, which 
also installs the terminal’s USB driver. You can use BGAN LaunchPad to open and manage data 
connections, manage and monitor terminal operations and monitor the status of the 
connections between your terminal and your computer. 

To install BGAN LaunchPad on your computer: 

1. Insert the Inmarsat BGAN LaunchPad Installation CD into your computer's CD-ROM drive.  

2. Follow the on-screen instructions.  

If you need more details, go to the section LaunchPad Software Installation  

When you start the BGAN LaunchPad application on your computer (TE) and connect to the 
Terminal, the Terminal will query the current USIM/SIM card to see if the Personal Identification 
Number (PIN) is enabled. If the PIN is enabled, the BGAN LaunchPad displays a PIN window and 
requires you to enter a valid SIM PIN. If the SIM PIN is disabled then the BGAN LaunchPad 
bypasses this display. The PIN should have been supplied with the USIM/SIM. 

You are now ready to obtain a GPS fix. 
 

OBTAINING A GPS FIX 
Your Satellite Terminal contains an integrated GPS receiver that is used to provide location 
information to the BGAN system. GPS location information is required to register with the BGAN 
system, and the terminal automatically tries to get a GPS every time it is powered on. 

The GPS antenna is located in the main antenna. For optimum GPS signal reception, make sure 
the Terminal is placed in a horizontal position pointed towards the sky. Since the GPS receiver 
needs to see at least 3 satellites, it should have visibility of a large part of the sky without 
obstructions from buildings, mountains or trees. So it might be necessary to take your Satellite 
Terminal out to a clear space to obtain a new GPS location. It may be possible to obtain a new 
GPS location in a less favorable circumstance, but the time to get the fix may be longer. 

Once the terminal gets a GPS fix, it stores the location, and the terminal can be moved to a 
more convenient working area, such as inside a building by a window facing the BGAN satellite.  

GENERAL INSTRUCTIONS 

1. Take the Satellite Terminal outside and lay it down flat. Verify that the unit has an open view 
of the sky to get a GPS fix. 

2. Power up the Terminal. The GPS LED will start to flash green indicating the terminal is getting a 
GPS fix. 

 

3. Monitor either the BGAN LaunchPad GPS indicator or the Terminal’s GPS LED for the status of 
the GPS fix. It may take a few minutes to get a fix. Once the terminal gets a GPS fix, the GPS 
LED will turn solid green. 

The following is the progression of the GPS LED display as the terminal tries to get a GPS fix: 

n Getting a fix:  The LED flashing green (½ duty cycle, 1 second period) indicates the terminal 
has not obtained a fix since it was last powered on. The stored fix may be acceptable in 
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which case the terminal may be able to register, but the LED will continue to flash indicating 
the terminal is still trying to get a fix. 

n Needs a fix:  The LED changes to flashing red (½ duty cycle, 1 second period) indicating that 
the terminal tried to register, but the GPS fix was rejected by the network.  

n Got a fix: The LED changes to solid green when a new GPS fix is obtained. The LED will remain 
on until the unit registers with the network and the fix is accepted. (Note that once the fix is 
obtained, the GPS receiver will be turned off unless it is still downloading almanac data from 
the GPS satellites) 

n Complete:  The LED turns off when the unit successfully registers with the network. 

n GPS Failure:  The LED will be solid red if the Terminal detects a hardware fault with the GPS 
module. 

 

You are now ready to Connect the Terminal to the Computer. 

 

CONNECTING THE TERMINAL TO THE COMPUTER 
You can connect your computer to the BGAN terminal with one or more of the following 
interfaces 

§ USB 

§ Ethernet 

§ Integrated Services Digital Network (ISDN) 

§ WLAN 

þ 
Note 

There is no need to check the active interface.  All interfaces can be used 
simultaneously to accommodate multiple users. 

 

 

 

 

þ 
Note 

During initial setup, the terminal can only be configured using either a USB or an 
Ethernet connection. Once the terminal has been configured, all four interfaces 
(USB, Ethernet, WLAN and ISDN) can be used for data transfer depending on the 
service required. 

Your computer must be configured to support your chosen connection method. 
Refer to the documentation supplied with your computer for details. 
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CONNECTING BY USB 

To connect the BGAN terminal to the computer using the USB port: 

1. Connect the supplied USB cable to your computer’s USB port, and insert the other end of the 
connector into the BGAN terminal’s USB port. 

 

 

2. At the terminal, slide the cable through the rubber door slot in order to secure and protect 
the connection.  

þ 
Note 

When plugging in the USB cable for the first time, you will see Windows installing a 
new driver for the device. 

 

When you install LaunchPad the USB driver for the terminal will also be installed. When you 
plug in the USB cable into your computer for the first time, your computer will detect that 
new USB Hardware has been connected. You should then follow the computer’s instruction 
to install the Hughes USB LAN LINK driver software (for computers using the Windows 
operating system, the installation is carried out using a Found New Hardware Wizard). Your  
computer will then use this driver to connect to the terminal.  
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CONNECTING BY ETHERNET 

To connect the BGAN terminal to the computer using Ethernet: 

1. Connect the supplied Ethernet cable to your computer’s Ethernet port, and insert the other 
end of the connector into the BGAN terminal’s Ethernet port. 

 

2. At the terminal, slide the cable through the rubber door slot in order to secure and protect 
the connection. 
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CONNECTING BY ISDN 

1. Connect the ISDN cable (use the provided Ethernet cable – it is a dual-use cable for both 
Ethernet and ISDN) to your computer’s or phone’s ISDN port, and insert the other end of the 
connector into the Terminal’s ISDN port. 

2. At the Terminal, slide the cable through the rubber door slot in order to secure and protect 
the connection. 

             

 

CONNECTING BY WLAN 
If you have not previously used the terminal’s WLAN interface, it has to be enabled from 
LaunchPad, with your computer connected to the terminal using either the USB or Ethernet 
interface. You can also enable the Wireless Encryption Protocol  for added security. When the 
terminal’s WLAN interface is enabled, the WLAN LED is either green (WEP is enabled) or red (WEP 
is not enabled). 

Then any computer with a WLAN interface can detect the terminal’s WLAN SSID, and connect 
to it automatically.   

Note:  If WEP is enabled, you must provide other WLAN users with the proper WEP key in order for 
them to connect to the terminal. 

You are now ready to Register with the Network. 
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CONNECTING WITH THE NETWORK 
Establishing a connection with the network requires the careful orientation of the BGAN terminal 
towards the satellite, a process called pointing. Accurate and precise pointing is important, 
because a badly-pointed antenna can reduce the data rate achievable over the network. 
When pointing is complete, you can register the terminal with the BGAN network. 

CHECKING THE GPS STATUS 

After you have connected your terminal to a computer, you can check the GPS status by 
opening BGAN LaunchPad. Refer to the BGAN LaunchPad status bar and the GPS indicator light 
on your BGAN terminal for the current GPS status. The table below indicates each possible status: 

LaunchPad Status 
bar symbol 

Terminal GPS indicator 
light 

Status 

 Flashing Green 

The terminal is getting a GPS fix after being 
turned on. If you have not changed location 
since last registering, you may be able to re-
register with your last valid fix. Otherwise wait 
until a new fix has been obtained before 
registering. 

 

Solid Green 
 
 

Off  

The terminal has a valid GPS fix. You are ready 
to point the terminal and register. 
 
The terminal has successfully registered. 

 Flashing Red 
The network will not allow you to register with 
the stored GPS fix. You need to get a new GPS 
fix. 

 Solid Red 
The GPS receiver in the terminal is faulty. 
Contact your Service Provider. 
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POINTING THE TERMINAL 
You can use the BGAN terminal signal quality indicator lights for pointing if you know 
approximately the direction to the BGAN satellite. If you need detailed pointing instructions you 
should use the BGAN LaunchPad pointing wizard. 

TERMINAL STAND POSITIONING 

The terminal’s stand is used to position the terminal in the correct direction. 

1. Place the Satellite Terminal on a flat surface. Find the knobs located on one side of the unit. 
Loosen the knobs by rotating them both towards the unit, in the direction shown. 

 
 

2. To prepare to lift the Terminal, place a finger in the lower right hand corner of the unit and 
place your other hand in the middle of the unit. 

  
 

3. Pull out the front stabilizer. Lay the Terminal back on the flat surface. 

 

4. Lift up the Terminal while referring to the protractor on the right-hand side. The protractor 
gives you the angle at which the unit is positioned. Note that an angle of 0 to 45 degrees is 
displayed on the inside portion of the protractor, while a 46 to 90 degree angle is displayed 
on the outside portion. To start, select an angle between 15 and 30 degrees. 
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5. After you have positioned the Terminal at the desired angle, tighten the knobs by turning 
them away from the unit. Tighten them so that they are firm and hold the angle but are still 
movable in case further adjustments are needed. Note that both knobs will gradually tighten 
if you push the unit to a lower angle. This can help with locking the unit when the desired 
protractor angle is close to 90 degrees.  

6. You can use the compass to pointing the terminal in the correct direction. Refer to the 
Antenna Pointing section for further instructions. 

 

 

 

þ 
Note 

Do not stand in front of the Antenna 

The Satellite Terminal emits radio frequency energy when in operation. Do not 
stand or place objects in front of the antenna when the terminal is operational. 

 



 

16 BGAN 9201 User Manual 

USING THE BGAN LAUNCHPAD POINTING WIZARD 

Inmarsat recommends that you use LaunchPad’s Pointing Wizard to point your Terminal to the 
satellite. You can also point your Terminal using the Terminal’s LEDs and audio indicator. 

 
The BGAN LaunchPad Pointing Wizard steps you through the process of pointing your terminal, 
and registers with the network. To do this, first start the BGAN LaunchPad on your computer. The 
status bar displays the message In Pointing Mode. 

1. Confirm your nearest city in the information box to the left of the map. You can change it by 
clicking on the map at your current location or click on nearest city and then select from the 
list. Your location will be used to determine the recommended antenna angle and compass 
direction.  Until you successfully register with the BGAN system, your GPS position will not be 
shown on the map. LaunchPad gives the compass direction in both degrees and direction, 
the compass shows direction as North, South, East and West, with 10 degree divisions. 

 
 

2. Click on Help me setup BGAN.  

3. Step through the instructions to correctly position the terminal. 
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4. When you are ready to register with the network, click on Register with Network now. Refer to 
Registering with the Network.  Note: You can also register with the network by pressing the 
“Audio” button on the terminal for 3-4 seconds.  Once the GPS light goes out, the terminal is 
registered with the network and you can start to make ISDN calls without the use of 
LaunchPad. 

5. When you have successfully registered with the network, your position will be displayed on 
the map, but only if allowed by local regulations. 

 

USING THE BGAN TERMINAL SIGNAL QUALITY LEDS 

To point the antenna using the LEDs: 

1. Set the angle and position of the BGAN terminal using the compass and the graduated 
scale. If you do not know the angle and position to set the terminal to, use the BGAN 
LaunchPad pointing wizard.  

Note the Pointing indicator LEDs as you point the terminal to obtain the maximum possible 
signal quality. 

 

2. The following table shows the colors of the pointing LEDs from the weakest to strongest, as 
you point the terminal to the BGAN satellite 
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3. When you have finished pointing the terminal, you are ready to register with the network. Go 
to the next section Registering with the Network. 

USING THE AUDIO BUZZER 

You can also monitor the signal quality using the audio buzzer. By default the audio buzzer is 
switched off. To use the buzzer when the terminal is in pointing mode: 

1. Press the audio button to turn the buzzer on.  

2. Monitor the signal quality using the buzzer. The higher the pitch and the shorter the interval 
between tones, the stronger the signal. 

 

3. When you have finished pointing the terminal, you are ready to register with the network. .  
Note: You can register with the network by pressing the “Audio” button on the terminal for 3-
4 seconds.  Once the GPS light goes out, the terminal is registered with the network and you 
can start to make ISDN calls without the use of LaunchPad. 

4. or Go to the next section Registering with the Network for registering with LaunchPad. 

5. When you register with the network, the buzzer turns off automatically.  

Note: If the audio button is pressed when the unit is not in pointing mode, it will have no 
effect. 

þ 
Note 

The audio buzzer will always default to off when the unit powers on. When the unit is 
In pointing mode, pressing the Audio button located in the front of the terminal 
turns the buzzer on. Pressing it again turns the buzzer off. Long pressing (3-4 
seconds) the Audio button starts registration with the network.  Once you exit 
pointing, the buzzer will turn off. If the Audio button is pressed when the unit is not in 
pointing mode, it will have no effect. 
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REGISTERING WITH THE NETWORK USING LAUNCHPAD 
When you have successfully pointed the antenna, you then need to exit antenna pointing, and 
register with the network. If you have an ISDN handset connected to the terminal, you can exit 
pointing and register by pressing the #1# keys. Otherwise click on the icon Register with network 
now on the BGAN LaunchPad pointing window. 

BGAN LaunchPad contains the following: 

LAUNCH BAR 

Click on any icon to display the associated tab, where you can perform BGAN LaunchPad 
functions. 

 

 

The launch bar options include: 

n Data connections − connecting to the Internet to browse Web sites and send and receive 
emails, and also using advanced applications such as video and FTP.  

n Text message options − sending and receiving text messages.  

n Phone options − Used as a phonebook only for ISDN.  Supplementary Services are activated 
with the ISDN handset via a series of button commands.  See Supplementary Services 
Section. 

n Usage information  − shows circuit switched and packet switched usage information.  

n Services information  − listing Service Provider support options.  

n Support information  − listing LaunchPad help and Service Provider contact details.  
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REGISTRATION STATUS AND COVERAGE MAP 

This area displays the registration date and time, location information and other registration 
information, and shows the expected coverage zone. 

Note: The map depicts BGAN's expectations of coverage, but does not represent a guarantee 
of service. The availability of service at the edge of coverage areas fluctuates depending on 
various conditions. 

 

 
STATUS BAR 

The Connected to status, terminal Status and Signal strength are all shown on the status bar, as 
shown below: 
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FIXED/SEMI-FIXED INSTALLATION 
The satellite terminal can be mounted on a pole or flat surface (such as a wall or roof) using the 
Fixed Mount Kit accessory. This kit includes all the installation brackets, mounting hardware, tools 
and instructions to complete the installation, except for the screws, bolts, etc. required to mount 
it to the structure.  Proper installation ensures that the terminal is always correctly pointed at the 
satellite. The terminal can then be left alone for an extended period of time without having to 
be re-pointed or set-up. The Fixed Mount Kit accessory can be re-used to install the terminal in 
different locations. 

When mounted in a  location where access to the terminal may not be straightforward (for 
example, mounted high on a wall), you may want the terminal to recover automatically after a 
power outage. To permit this, the following automatic mode settings are recommended (see 
the Automatic Mode section for more details): 

n Auto “on” mode is enabled 

n LED off mode is enabled 

n Antenna pointing bypass is enabled 

n Automatic context activation is enabled 

n SIM PIN entry is disabled 
 

In addition, it is recommended that the battery be removed to prevent it being damaged at 
extreme temperatures.
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 LAUNCHPAD SOFTWARE INSTALLATION 
 

SUPPORTED OPERATING SYSTEMS 
The Satellite Terminal supports the following Laptop/PC operating systems: 

n Microsoft Windows® Vista, XP and 2000 

n Linux Red Hat 9 - KDE 3.1.10 (Kernel Version 2.4.20-8). Note that the terminal’s USB interface is 
not supported with this operating system. 

n Mac 10.x (PC & Intel based MACs) 

þ 
Note 

You must disconnect any existing LAN connections on your PC before proceeding with 
installation. This avoids any conflict with the network configuration that you are setting 
up for the Satellite Terminal. 

You must verify that the proxy server settings in your browser are disabled. For Microsoft 
Internet Explorer, select Tools / Internet Options / Connections / LAN Settings and 
uncheck the box labeled “Use a proxy server for your LAN.” For Netscape, go to 
Advanced Preferences and select “Direct connection to the Internet.” When 
complete please close your browser.  DO NOT FORGET TO RECHECK THIS BOX ON 
RETURN TO YOUR OTHER INTERNET CONNECTION. 

 

BGAN LAUNCHPAD CORPORATE EDITION OR PERSONAL EDITION 

You can install either the Personal Edition or the Corporate Edition. 

BGAN LaunchPad Personal Edition is designed for personal use: 

n All BGAN LaunchPad features are available 

n You can personalize all of BGAN LaunchPad's functions and features without restriction.  
 

BGAN LaunchPad Corporate Edition is for corporate users: 

n A user profile is required with the corporate edition. A user profile is created with a separate 
application called BGAN LaunchPad Corporate Profile Maker.  

n The user profile defines user restrictions so some features may not be available to you, 
depending on the configuration that has been set up by your Corporate IT Manager or 
service provider.  

n You are asked to enter a username and password when logging in to BGAN LaunchPad.  
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INSTALLATION CD AND INSTALLATION WIZARD 
Insert the installation CD into your computer’s CD-ROM drive to start software installation. If the 
Installation Wizard, the program which guides you through the installation process, does not 
automatically begin, use Windows® Explorer or Mac OS X Finder to find setup.exe on the 
installation CD, double-click on this to start the Installation Wizard. 

The following steps show the installation process: 

1. The Installer prepare to install the LaunchPad software, and asks you to select the language 
and accept the licensing agreement. 
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2. Follow the on-screen instructions. Note the following recommended choices : 

§ Make sure you select the appropriate Edition (Corporate or Personal ) when prompted. 

   

§ Special Corporate Edition Instruction: 

− Inmarsat recommends that you install BGAN LaunchPad Profile Manager with the 
Corporate Edition. If you want to install Profile Manager, select Browse CD for any 
extra features, and follow the on-screen instructions.  

 

3. Select the directory into which LaunchPad will be installed. 
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Other items for selection and installation messages: 

§ Shortcut Destination Selection 

 
 

§ Pre-Installation Summary 
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§ Installation Complete 

 

 

PLEASE NOTE that the BGANLaunchPad version numbers shown in these examples will most likely 
be different than the versions numbers you will see when you perform the installation. 
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 TERMINAL OVERVIEW 
 

SIZE AND WEIGHT 
The Satellite Terminal is 27.5 cm x 34.5 cm x 5.0 cm.  Its weight is 2.8 kg (including the battery). 

The small size and weight allows you to easily move it from site to site, and it can be connected 
at a new site in minutes. 

TERMINAL INTERFACES 

INTERFACE OVERVIEW AND DEFAULTS 

The Satellite Terminal includes four interfaces that can connect to your computer.  

n Ethernet 

n USB 

n ISDN (for voice and data) 

n WLAN (IEEE 802.11b) 

By default the ISDN, USB and Ethernet interfaces are active when the unit is turned on. The 
802.11b Wireless LAN (WLAN) interface is disabled by factory default, but by using the BGAN 
LaunchPad you can configure the WLAN to be on at startup. 

When the Terminal is connected to a DC power source, such as mains, the ISDN interface 
remains on at all times. When running from the battery, the ISDN interface will turn off 5 minutes 
after pointing is completed if no ISDN device is connected. You can re-enable the ISDN 
interface from the BGAN LaunchPad if you subsequently need to connect an ISDN device. This 
saves power and maximizes operating times because the power sourcing circuitry uses power 
even if no device is connected. If an ISDN device is connected at power up and then 
disconnected before the timer expires, the ISDN interface will power off.  

The following table summarizes the interface on/off behavior during battery and DC Power 
operation. 

Interface Battery Operation DC Power Operation 

USB On On 

Ethernet On On 

ISDN On. 

After 5 minutes if no ISDN 
device detected, turns off. 

On 

Off 
(default) 

Off Off WLAN 

Enabled On On 
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ESTABLISHING COMMUNICATIONS BETWEEN COMPUTER AND UT  

ETHERNET 

Ethernet communications are established by connecting your computer Ethernet LAN port 
directly to the Satellite Terminal LAN port via the supplied Ethernet cable and monitoring the 
BGAN LaunchPad for the connection.  
 

USB 

USB communications are established by connecting your computer USB port directly to the 
Satellite Terminal LAN port via the supplied USB cable and monitoring the BGAN LaunchPad for 
the connection.  Please ensure that you have the USB driver installed. 
 

ISDN 

ISDN communications are established by connecting your computer ISDN port or ISDN device 
directly to the Satellite Terminal ISDN port via the supplied ISDN cable (same as the Ethernet 
cable). 

With the ISDN interface you can make voice or data calls. Only one terminal at a time may 
make a call since only one B channel is supported per Terminal in the BGAN system. However, 
up to four ISDN phones may be utilized with the one ISDN connection, using a passive ISDN 
splitter. Only one of the ISDN devices may make a call at one time..  

WLAN 

The WLAN function is used in access point mode. You can use the BGAN LaunchPad to 
configure the following parameters: 

n Wireless LAN interface on/off. The default is off. 

n Network (SSID) name. The default is “BGAN” but you can change it. 

n Channel number. This controls the radio channel number (1-14) used by the access point. 
Depending on the country only certain subsets of these channels may be used (3 options: 
France, Spain or Rest of the World). Channel 11 is common to almost all countries, so it is 
used as the default. 

n Encryption. 64 or 128 bit WEP encryption can be enabled. Up to 4 WEP keys can be entered, 
in either Hexadecimal or ASCI format. 

n Note: Not all Operating Systems will convert ASCI to hexadecimal when setting up a WLAN 
connection. If you have any problems, please use the hexadecimal WEP key to connect 
your computer to the terminal. 
 

Up to eleven WLAN users can access the Satellite Terminal simultaneously.  
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TERMINAL FEATURES 

USIM/SIM  CARD 

 

The USIM contains an identity that uniquely identifies a subscriber. The USIM provides storage for 
subscription and subscriber related information.  

Access to the USIM, and therefore to the BGAN system, can be restricted to an authorized user 
or number of users, using the USIM Personal Identification Number (PIN). The PIN is stored securely 
in the USIM. 

The USIM personalization feature ensures that access to a terminal or other user equipment can 
be restricted to an authorized USIM. The USIM and the terminal share a code stored securely in 
the USIM and the terminal. If a USIM fails to prove its knowledge of the code, it is denied access 
to the terminal. 

If the USIM is removed during operation, the terminal will deactivate any active PDP contexts, 
detach from the network, and enter a "NO SIM" operational mode. If the USIM is reinserted while 
the terminal is still powered on, it must be restarted to detect the new or replaced USIM. 

BUTTONS 

The Satellite Terminal has two buttons:  

 

 

n The Power button is used for turning the terminal on or off. A long press of the button w ill 
either turn it on or off. 

n The Audio button is used for switching the audio tones on and off. These tones are useful 
during pointing mode (see the section Using the Audio Buzzer). Press the button to turn the 
tones on and off. 

n Once you have the terminal correctly pointed to the satellite, you can long press (3-4 
seconds) the “Audio” button to register with the network.  You can tell when you are 
registered with the network when the solid green GPS LED goes out. 
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INDICATOR LIGHTS (LEDS) 

The LEDs indicate the status of the Satellite Terminal. The figures below illustrate where the LEDs 
are located on the terminal and the functions of each. 

POWER LED 

 

 

The Power LED indicates power status.  

LED Status 

Off Terminal is turned off. 

Green Terminal is powered on. 

Flashing Red Fault detected. 

Flashing 
Green 

Operating on battery power, or the power button has been 
pressed and the terminal is powering down. 
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BATTERY LED 

 

The Battery LED indicates the battery status and functions differently depending on whether the 
terminal is powered from an external power adapter or from the internal battery. 

LED External Power Adapter – Status 

Off No battery. 

Green Battery fully charged. 

Flashing 
Green 

Battery charging. 

Flashing Red Battery Fault – not charging 

  

LED Internal Battery – Status 

Off Unit is off. 

Green Terminal on, in pointing mode. 

Flashing 
Green 

Terminal on, pointing completed. 

Flashing Red 
(fast) 

Terminal on, battery low (Power LED is green) 

Flashing Red 
(slow) 

Terminal on, battery fault detected (Power LED is also flashing 
red) 

 

POINTING LEDS  

 

These six, two-color LEDs are used during power-up, Antenna Pointing, and ACA (automatic 
Context activation (See ACA Section) 

When the terminal is powered on, the power LED turns green. As the Satellite Terminal progresses 
through the power-on self tests, each of the 6 pointing LEDs turn green or red/green in turn, and 
then turn off if the terminal successfully completed power-on self-test. See the Power-On Self Test 
section for full details. 
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These LEDs also indicate the signal quality during antenna pointing, see the Antenna Pointing 
section in the First Time Setup chapter for full details).  

WIRELESS LAN LED  

 

 

n This LED is green if Wireless LAN is on and Wireless Encryption Protocol (WEP) is enabled. 

n It is red if Wireless LAN is on and WEP is disabled. 

n If Wireless LAN is enabled and the terminal is operating off battery power, the LED flashes at 
1/8 duty cycle 1-second period to save power, after the unit exits pointing. 
 

GPS LED  

 

The GPS unit in the Satellite Terminal will attempt to get a GPS fix each time the unit powers up. 
The GPS LED indicates the state of the GPS fix. See Obtaining a GPS Fix section. 

COMPASS 

 

Use the compass during the Antenna Pointing process to point the terminal in the direction of 
the satellite. The BGAN LaunchPad can be used to determine the correct direction. North is 0 
degrees, East 90 degrees, South 180 degrees, West 270 degrees, each division on the compass 
corresponds to 10 degrees. 

þ 
Note 

The compass accuracy can be affected if the terminal is placed close to 
magnetic fields or metallic objects. 
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SOLAR PANEL COMPATIBILITY 

The terminal is compatible with solar panels. The easiest way to interface to a solar panel is 
through the supplied DC Power Adapter (HNS P/N 3004065-0001). The output of the DC power 
adapter is plugged into the terminal, with the input (cigarette lighter adapter) connected to the 
output of the solar panel. 

The terminal has been tested to work with the following solar panels: 

n IDG T-60 (3 panels) form IDG Europe (60W max, 3.3A at max power) 

n SunCatcher F0001 (2 panels) from Powerline Electronics Accessories (14.5W max) 

n 55 Watt Solar West Panel  

 

TERMINAL ACCESSORIES 
Terminal accessories include: 

n DC Power Adapter 

n Extended Battery 

n AC Power Adapter (w/30mm Cable) 

n Cables 

n Compatible Devices 

n Fixed Installation Kit 

Each is described in this section. 

DC POWER ADAPTER 

 

The DC power adapter can be purchased through your distributor or supplier. It has an 
operating temperature range of -25ºC to +55ºC and provides an output voltage of 20 VDC. It 
can be used with input voltages in the range 10 to 32VDC. 

EXTENDED BATTERY 
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The Extended lithium ion battery pack can be purchased through your distributor or supplier. The 
Extended battery pack has the same form factor as the standard battery pack, with 50% more 
capacity.   

AC POWER ADAPTER 

 

The AC power adapter is for indoor use only.  It has an indoor operating temperature range of 
0ºC to +40ºC and provides an output voltage of 20 VDC. 

When the Satellite Terminal is first connected to AC power, the unit powers on automatically. 
Note that the Terminal will still charge the battery if it is turned off. 

CABLES 

The Satellite Terminal package comes with a USB cable and cables that provide Ethernet and 
ISDN connections. 

n USB cable  

 

n Ethernet/ISDN 10 meter cable  

 

 

When the Terminal is connected to a PC or laptop it uses a regular Ethernet cable. If the Terminal 
is connected to a LAN hub, a "crossover" LAN cable is required. 

FIXED MOUNT KIT 

The following items are found in the Fixed Mount Kit. The user is responsible for mounting the 
hardware to a suitable surface. 

n Fixed Mount Screws (Theft-Proof) 
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n 30 meter Cord for AC Power Adaptor  

 

This allows the AC Main power adaptor to be located up to 30 meters away from the 
terminal.  

 

n Ethernet/ISDN 30 meter cable  

 

EXTERNAL ANTENNA 

n The external antenna is a 20” x 20” x .5” passive antenna with a 10 meter long cable. It can 
be mounted permanently using the Fixed Mount Kit accessory. 
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ISDN COMPATIBLE DEVICES 

The terminal has been successfully tested with the following ISDN handsets: 

n ASCOM Eurit 33 plus 

n SwissVoice Eurit 25   

n Nera ISDN handsets (old Fleet and new WorldPro handsets) 

n Siemens Gigaset SX255 

n Hughes 2-4 Wire terminal adapter using any 2-wire analog handset 
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 USING THE HUGHES UT WEB MMI 
 

ACCESSING THE UT WEB MMI 
 
The Hughes UT now includes its own internal Web MMI.  To access the UT Web MMI,  open your 
favorite Web Browser and type in the internal IP address of the UT e.g. http://192.168.128.100.  
The web MMI opens up to the “Properties” page as shown below: 
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PROPERTIES PAGE 
 

The Properties page shows the current status of the UT.  A description of each item on the page 
follows: 

 

In the Top left-hand corner of the screen you will notice that there are three status items: Satellite 
Signal Strength, Beam ID, and battery status.  These items are updated automatically when 
status of that item changes. 

Network Status:  This shows the current status of the network and there are two messages that 
appear in this field: 

1. Registration Status:  This filed indicates whether you are Registered with the Network.  
Click on the “Register with Network” button.  Note: For the 9250, bypass antenna pointing 
is turned on as default so it will automatically register with the Network each time. 
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2. PS Attach Status:  This indicates whether you are PS (Packet Switch) attached with the 
Network.   You will still need to setup a PDP context in order to send PS data.    

3. CS Attached: This indicates whether you are CS (Circuit Switch) attached with the 
Network.  Once you are CS Attached and Registered with the network, you are able to 
make CS calls. 

4. GPS Position: This field displays the current GPS position status.  If you have received a 
GPS fix and the Network GPS policy has been received and it allows the GPS position to 
be shown to the user, it will display the Latitude, Longitude, Fix Quality, and the Last time 
the GPS position was updated.  Time displayed is GMT time. 

5. Emergency Call Numbers: This field displays the Emergency call numbers that can be 
used with the UT. 

6. Software Version:  This displays the current version of software that is running on the UT. 

7. Satellite Modem IMEI:  This displays the IMEI number of the UT. 

8. Satellite Modem IMSI:  This displays the IMSI number of the USIM card in the UT. If is the 
IMSI is not displayed, it indicates that there is a problem reading the SIM card, e.g. 
because there is no SIM, it is installed incorrectly or PIN must be entered. 

9. USIM PIN Status: This field indicates whether the USIM is ready or the PIN has to be 
entered. If the PIN needs to be entered, go to the SETUP page. 

10. USIM APN Name: This displays the default APN that has been provisioned on the USIM 
card.  Note that some USIM cards may have multiple APN’s provisioned on them. 

11. MS-ISDN 1 thru 4:  Every USIM card has four (4) separate MS-ISDN numbers if the USIM has 
been provisioned for these services.  MS_ISDN 1 is for 4K Speech, MS-ISDN 2 is for 3.1KHz 
Audio (fax, etc.), MS-ISDN 3 is for UDI data and MS-ISDN 4 is for RDI data. 

12. Extract System Log: Clicking this button allows the User to automatically extract a UT 
system log and save the file to a location on the TE for debugging purposes.  This file can 
be e-mailed to Hughes directly for fault analysis if the User experiences any problems. 

13. Restore factory Defaults:  Clicking this button will restore the UT back to factory defaults 
and delete any of the User parameters that have been set-up in the UT.  Hughes highly 
recommends that the User exhaust all possible debug procedures before using this 
feature.   
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SETUP PAGE 
The Setup page allows the User to configure various parameters of the UT.  A description of each 
item on the page follows: 

 

1. Terminal Local IP Address:  This allows the User to change the local IP address of the 
terminal from the default 192.168.128.100 IP address.  Only the last two octets are 
available to change.  Once the local IP address is changed on this page and applied, 
the IP address ranges for the DHCP server, the PDP Context page and ACA page will also 
be changed automatically.  Note:  Updates to this field will not take affect until the UT is 
rebooted. 

2. DHCP Address Range:  This allows the User to set the range of DHCP addresses that are 
given out by the UT to any connected TE. 

3. Idle-mode DHCP Lease Time:  Idle-mode DHCP Lease Time refers to the DHCP lease time  
when the UT is not connected to the network.  This parameter allows the User to change 
the default time (60 seconds) that the DHCP lease to the TE is good for.  This parameter 
was introduced because of a problem with some models of Cisco routers that will not 
accept a short DHCP lease time.  Note:  The longer the Idle-mode DHCP lease time, the 



 

BGAN 9201 User Manual 41 

longer it will take the Network/UT to update the TE with the correct DNS servers for web 
browsing after establishing a PDP context. 

4. Connected-mode DHCP Lease Time:  The Connected -mode DHCP Lease Time refers to 
the DHCP lease time  when the UT is connected to the network.  Most Users will have no 
need to change this parameter.  

5. PIN and PUK: The PIN and PUK fields indicate whether the PIN or PUK needs to be entered 
to unlock the terminal. When greyed out they indicate the PIN is not required or is 
already satisfied. 

6. Bypass Antenna Pointing:   This parameter allows the User to bypass antenna pointing and 
have the UT go straight into Registering with the Network.  This is turned “on” as default for 
the 9250.   

7. Auto Power On:  This parameter is used when the User wants the UT to power up 
automatically if AC/DC power is applied to the UT. 

8. 24/7 PDP Keep Alive:  This is setting is for keeping a PDP context alive indefinitely.  Note:  
This parameter should not be checked unless you have a critical need to keep the PDP 
context alive for critical information.  This is not a good use of satellite resources. 

9. Satellite Selection:  This parameter is used within a satellite overlap region and allows the 
user to override the default satellite (selected by the 9250 based upon elevation 
angle/GPS location) and select a different satellite.  Note: This change does not take 
affect until the UT is reset. 

10. Net mode: Most users will use NAT mode for their application.  Bridge mode requires the 
TE to be intelligent enough to handle two IP addresses and to be able to route traffic to 
either address. One address is the UT’s private IP address and the other is the public IP 
address assigned by the network when a PDP context is activated. 

11. Streaming Activity Timer:  This allows the user to turn On a timer for inactivity for a 
Streaming QoS that has been setup.  The timer is in seconds and will tear down a 
streaming context after X seconds of inactivity. 

12. Emergency Call Numbers:  Allows the User to update the emergency call number that is 
applicable in that part of the world where the terminal is being used. 

13. Apply, Cancel, and Restart Terminal buttons:   These buttons are self explanatory. 
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STATISTICS 
This web page provides an estimate of the amount of Packet Switched data sent and received, 
along with time spent on a CS call.  The data is broken up into three types: 

Session:  The PS session statistics track the cumulative PS data sent and received on background 
PDP contexts since the unit was powered on.  CS sessions statistics track the time of the last call. 

Trip:  The trip counter is similar to the trip counter on your vehicle.  It can be zeroed out at 
anytime by the user and it will track the statistics until the User resets it. 

Lifetime:  The Lifetime counter is similar to the odometer on your vehicle.  It shows the statistics of 
the terminal since the software version that added this feature was loaded onto the UT.  The User 
cannot reset these counters.  

 

 

Note: If the UT power is abruptly disconnected for some reason, the UT will not be able to 
save the statistics to flash and hence the statistics for the session maybe inaccurate.
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PDP CONTEXTS 
The PDP Context page allows the User to setup and configure PDP contexts for any TE that is 
connected to the UT.  To activate a PDP Context, go to the bottom of the page.  You will see 
the CID, Local IP Address, APN, Requested QoS, Username and Password fields. 

 

1. CID:  The CID of each context is automatic by default.  If for some reason the User 
wants to assign a particular context to a specific CID, use the drop down arrow and 
select the wanted CID number.  Most users will not need to change this field from the 
automatic default setting. 

2. Local IP Address:  This is the local IP address of the TE that you want to setup a PDP 
context for.  Note that the first three octets of the IP address will reflect any changes 
made in the setup screen to the UT local IP address. You can use the “ipconfig” 
command from a “cmd” window to find the IP address of a PC. 

3. APN name:  This field is configurable, but it will always show the default APN that has 
been provisioned on the USIM.  If you have a USIM that has been provisioned with 
multiple APN’s, you can type in any of these secondary APN names as part of the 
PDP context setup. 

4. Requested QoS:  The drop down list shows all of the different QoS types: background, 
streaming 32K, streaming 64K, streaming 128K, and streaming 256K.  Select the 
appropriate QoS required for the PDP context that you are setting up. 
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5. Username (UN)/Password (PW): Some Service Providers require a Username and 
Password to be used when setting up a PDP context.  This is often required when 
using Static Global IP addresses assigned by the Service provider. 

Activating a PDP Context: 

To activate a PDP context, perform the following instructions: 

Do not modify the CID field unless you need to setup a specific ID for one of your devices.  
Leaving it blank will allow the software to automatically choose the next CID that is available.   

Next, type in the local IP address of the device that you want to setup the connection for.  The 
APN is read from the USIM card and is usually not changed unless you have more than one APN 
provisioned on the USIM card.   

Next, select the QoS that is needed by selecting it from the drop down list.   

If your Service Provider requires a UN and PW, enter it in the Username and Password boxes, then 
click on “Apply”.   

The new connection will show up in the table above (See screen shot below for example).   

 

  

Background Context activated for 192.168.128.101
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Once the context has been setup, whether it is successful or not, the context field will always be 
populated until you click on the “Clear” box.  This allows you to be able to retry/reactive the 
existing context parameters (See CID #1 below). 

 

You can tell if a context is active by looking to see if the Global IP Address and DNS fields are 
populated.  If they are populated, the context is active. 

 

CID #1 Inactive; CID #2 & 3 active 
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Activating Multiple PDP Contexts 

To activate multiple PDP contexts for additional TE devices, follow the same procedures above.  
Each time you activate a context for a particular local IP address, it will show up in the table as 
shown in the screenshot below. 
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WLAN 

Connecting by WLAN 

If you have not previously used the terminal’s WLAN interface, it has to be enabled from the web 
MMI, with your computer connected to the terminal using the Ethernet interface.  

n Wireless LAN interface enabled/disabled: The default is disabled. 

n Network (SSID) name: The default is “BGAN” but you can change it to whatever you want. 

n Channel number: This controls the radio channel number (1-14) used by the access point. 
Depending on the country only certain subsets of these channels may be used (3 options: 
France, Spain or Rest of the World). Channel 11 is common to almost all countries, so it is 
used as the default. 

 



 

48 BGAN 9201 User Manual 

 

WEP SECURITY 
WEP Protection Status:  Click on “On” from the drop down list to enable the Wireless Encryption 
Protocol (WEP) for added security. When the terminal’s WLAN interface is enabled, the WLAN 
LED is either green (WEP is enabled) or red (WEP is not enabled).  When the LED is red, any 
computer with a WLAN interface can detect the terminal’s WLAN SSID, and connect to it 
automatically.   

 

n Encryption Level:  64 or 128 bit WEP encryption can be enabled.  

n WEP Key 1:  Default WEP keys are formulated using the IMEI number of the terminal.  If you 
want to use different WEP keys, please use the following table as a reference when entering 
the new WEP keys: 

n Hexadecimal 128-bit: Requires 26 characters. Recommended  

n Hexadecimal 64-bit: Requires 10 characters 

Note:  If WEP is enabled, you must provide other WLAN users with the proper WEP key in order for 
them to connect to the terminal.  Please write down the WEP key that you use because once 
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entered, there is no way to view this key again.  You will have to disable WEP, reboot the 
terminal and set it back up again if the WEP key is forgotten. 

SSID Broadcast:  For added security you can choose not to broadcast your SSID. 

 

MAC Filtering:  For added security, click on ENABLE from the drop down list and then you can 
choose up to 10 selected MAC addresses that are allowed to connect to your WLAN.  Note:  To 
find out what the MAC address of a any TE is, go to a DoS prompt and type ipconfig /all. 

 



 

50 BGAN 9201 User Manual 

 

ACA 
This web page allows you to use Automatic Context Activation (ACA) in two different ways; 
using static IP addresses in the TE device you can establish an automatic PDP context with 
any QoS that is offered by the network (upper half of the web page), or, using DHCP from 
the UT, you can establish an automatic background PDP context for any TE that connects to 
the UT (lower part of the web page). 

ACA settings for TEs with Static IP address: 

Previously the static IP addresses used for ACA used specific blocks of IP addresses for the 
various QoS types.  Now you can setup your own range of static IP addresses for setting up 
an automatic PDP context with any of the QoS’s offered by the network.   

To turn on a particular range of addresses, select the “On” radio button and choose a range 
of addresses, low and high to use (e.g. 192.168.128.1 to 192.168.128.10). 

Next select the desired QoS for that range of IP addresses (32K streaming).  The APN listed is 
the default APN read from the USIM card (bgan.inmarsat.com).  If your USIM is provisioned 
for more than one APN, then you can type a secondary APN in this field.   

Next, if your Service Provider requires a UN and PW, enter it in the next two fields.   
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If you want to setup additional ranges of addresses, please follow the same instructions as 
above.  Note: You cannot overlap the IP address ranges.  If you do, an error will pop-up 
telling you that you have an overlap region.  Check all of the ranges for overlaps and try 
again. 

When you are finished, click on “Apply” and you should see a message saying “Operation 
Successful” as shown below. 

 

 

ACA settings for TEs using DHCP assigned IP address:  This option allows you to set up the UT 
for dynamic background ACA.  This means that any device connected to the UT, will 
automatically receive a background PDP context. 

To activate this feature, select the “On” radio button under ACA settings for TEs using DHCP 
assigned IP address and click on “Apply”. 
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To see if the context has been setup properly, click on PDP Contexts page and this will show 
you all contexts that have been setup (active or inactive).  See screen shot below. 
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ISDN 
You can establish ISDN data communication by connecting your ISDN equipment directly to the 
BGAN Terminal’s ISDN port with the supplied ISDN cable (which is the same as the Ethernet 
cable). This web page allows you to activate 40V power sourcing on the ISDN interface, and set 
MSN numbering options.  

 

4. ISDN Power Sourcing:  To turn on the ISDN power sourcing click on the “On” radio button.  
The ISDN device should receive 40V power immediately via the ISDN cable. This field should 
be on unless you never use ISDN or are using an ISDN device that has its own power source.  

5. MSN Speech: By default, MSN 1 is entered into the MSN Speech number text box. To receive 
incoming calls, you must program the same MSN into your ISDN handset connected to the 
ISDN port. 

6. MSN 3.1 KHz audio: By default, MSN 2 is entered into the MSN 3.1 KHz Audio number text box. 
To receive incoming calls, you must program the same MSN into your ISDN fax machine 
connected to the ISDN port. 

7. MSN UDI (Unrestricted Digital Information):  By default, MSN 3 is entered into the MSN UDI text 
box. UDI is a 64 Kbps service that is a European standard ISDN data service. 
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8. MSN RDI (Restricted Digital Information): By default, MSN 3 is entered into the MSN RDI text 
box.  RDI is a 56 Kbps service that is normally found in the USA. 

9. Trigger for Mobile-Originated call type (Bearer):  This box controls the mechanism used by 
the terminal to select the bearer type for mobile originated calls. By default, “Bearer 
capability” is set as the trigger in this text box.  There is also an option under the drop down 
arrow to set the trigger to use the MSN rather than the bearer. Most ISDN devices correctly 
signal the call type (speech, 3.1KHz audio, UDI, RDI) via the bearer capability. If there is a 
problem, this field can be changed to use the MSN number instead. 

 

Once all changes have been made, click on “Apply”.  Any changes to this screen require a re-
boot of the terminal to save the new configuration. Use the power button on the UT or the 
“Restart Terminal” button to gracefully power down and power back up the UT.  
 

Note: You can use different MSNs for any of the ISDN call types above, but your ISDN equipment 
must be programmed with the same MSN to accept incoming calls, and you must use different 
numbers for speech, audio and UDI/RDI calls.  
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ANTENNA 
This web page is only used for the 9250 tracking antenna.  It allows you to monitor the status 
of the antenna. Note: This page does not automatically update and must be refreshed to 
poll for the latest status. 

ATB State: This field indicates the detailed state of the antenna tracking board and indicates 
whether the antenna is tracking or searching for the satellite 

Elevation: the current elevation angle of the antenna  

Frequency (KHz): the frequency of the global beam in kHz that the antenna is tracking 

Antenna Tracking: indicates (TRUE or FALSE) whether or not the antenna is currently tracking 
the satellite 
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Additional Information on the various antenna parameters (ATB states) are shown below: 

 
#  State name    State Description 
0  INIT_ST     Initial state 
1 IDLE_ST    Wait on a frequency from the TU 
2  AZ_SEEK1_ST    Determine min/max signal levels in a full sky scan 
3  AZ_SEEK2_ST    Find azimuth direction 
4  AZ_SEEK_ELEVATION_ST Determine min/max signal levels on a single elevation 
5  TR_TUNE_EL_ST    Track and tune elevation state 
6  TR_TUNE_PLL_ST   Track and tune PLL state 
7  TRACK_ST    Track state 
8  BLOCK_ST    Blocked state 
9  FREEZE_ST    Antenna has stopped all motors 
10 (0x0A) TEST_ST    Test state 
 
The field at the bottom of the page is true/false indicating whether the antenna is tracking, i.e. in 
states 5, 6 or 7. 
 
The frequency is the frequency of the global beam. Possible values are the primary and 
secondary frequencies of the 3 satellites. 
 
Satellite ID Satellite   Primary   Alternate  
  Longitude  Freq kHz  Freq kHz  

I4-F1   64.0 E   1537485  1540825 Old position 

I4-F1   143.5 E   1537485  1540825 New position 

I4-F2   53.0 W   1537920  1541115 Old position 

I4-F2   25.0 E   1537920  1541115 New position 

I4-F3   98.0W    1537070  1540730 
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 BGAN LAUNCHPAD OVERVIEW 
The BGAN User Interface is called BGAN LaunchPad, and allows you to view and manage the 
terminal’s operations and status via a user-friendly set of tools installed on your computer.  

This is the screen that is displayed when you first start LaunchPad. 

 

 

PIN CODE ENTRY 
When the BGAN LaunchPad is started and connects to the Satellite Terminal, the terminal 
queries the current SIM card to see if the SIM PIN is enabled.  If the SIM PIN is enabled, the BGAN 
LaunchPad displays a SIM PIN window and asks for a valid SIM PIN before service is enabled.   
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If the SIM PIN is disabled then the BGAN LaunchPad will bypass this display. 

 

PERSONALIZATION 
After the PIN check, if Personalization is enabled and any checks fail, the BGAN LaunchPad 
displays the Security window and asks you to enter a valid de-personalization code. If all 
Personalization checks pass, the terminal will bypass the Security window. If personalization is 
enabled, the de-personalization code should have been supplied with the USIM/SIM. 

 

POINTING 
After the PIN and Personalization checks, the pointing screen is displayed. Once you have 
completed pointing, click the Register with Network Now button to exit pointing and connect to 
the network. 

See the section on Pointing the Terminal : Using the BGAN LaunchPad Pointing Wizard for details 
on how to use the Pointing Screen. 
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MAIN DISPLAY 
Once all the initial checks have been completed, the main BGAN LaunchPad page is 
displayed, showing progress towards acquiring the network. 

 

 

MULTIPLE USERS 
Up to 11 users attached to the Ethernet, USB and Wireless LAN interfaces can access the BGAN 
LaunchPad at the same time.  

In a multi-user scenario, each user must establish their own PDP context with the network, either 
using LaunchPad or the ACA feature.  

 

SOFTWARE DOWNLOAD/UPGRADE 
You should periodically check for new software releases for the terminal. Upgrading the 
terminal’s software is a two-phase process controlled by an upgrader in the BGAN LaunchPad. 
The Upgrader is accessed from a drop down menu in the BGAN LaunchPad. 

During the first phase, the terminal software is downloaded from an Internet server to your 
computer. The computer may utilize the BGAN network or any other accessible network to 
obtain the new software image.  
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In the second phase, the Upgrader loads the software from your computer onto the satellite 
terminal. If the upgrade fails, the old software is available on your computer and can be re-
downloaded to the satellite terminal. 
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CONNECTING TERMINAL TO PC AND OTHER DEVICES VIA WLAN INTERFACE 
The terminal provides a WLAN interface to any computer which as a WLAN interface. 

The terminal’s WLAN interface is configurable via the BGAN LaunchPad, as follows: 

1. From the BGAN LaunchPad main menu, select Terminal > WLAN Interface Settings. The 
Configure WLAN Interface dialog box is then displayed: 

  

 

2. Select Enable to activate the WLAN interface. 

3. Enter a Network Name (SSID). The default is BGAN, but you can change this if required. 

4. Select a Region from the drop-down list  (France, Spain, or The rest of the World). 

5. Select a Channel number  from the drop-down list. This controls the channel number (1-14) 
used by the access point. Depending on the country only certain options are available for 
selection. Channel 11 is common to almost all regulatory options, and so is the default. 

6. Select a WEP Key Length from the drop-down list. There are two key lengths available, 64 bit 
and 128 bit. 128 bit offers a higher level of security, but may cause a slight decrease in 
performance.  

7. Select a WEP Key Format at the Enter WEP key in: text box. This can be either Hex or ASCII. 
Hex keys use hexadecimal numbers (0-9, A-F) to encrypt and decrypt data, and are the 
most widely supported format. Plain text (ASCII) keys are supported on some operating 
systems (check that your operating system supports ASCII before you select this option). 

8. Enter up to four WEP Keys. The format depends on whether you selected Hex or ASCII.  

§ Hex – Enter a two digit hexadecimal number (0-9, A-F) in each box on the WEP Key 1 row. 
You can enter up to four keys in total, and you should change the default key periodically 
for added security. 

§ ASCII – Enter a string of 5 characters for 64 bit encryption, or 13 characters for 128 bit 
encryption. You can enter up to four keys in total, and you should change the default key 
periodically for added security. Note: Not all operating systems can convert ASCI to 
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hexadecimal format. If you have problems connecting via WLAN using an ASCI WEP key, 
try using the hexadecimal WEP key instead. 

Note: Check that each key that you set up here is exactly the same as each key on your 
computer’s WLAN interface; ie. WEP Key 1 on the LaunchPad must be the same as Key 1 
on the computer WLAN interface, and so on. 

9. Click OK to save the changes, Cancel  to exit without saving, or Apply to apply the settings 
for this WLAN session only. 
 

The following table summarizes the default settings. 
 

Parameter Description Default 

Wireless access 
Turn on/off 
WLAN 
Interface 

Disabled 

Network Name 
(SSID) 

Sets the SSID 
BGAN 

Region 
Region of 
Operation 

Rest of the 
world 

Channel 
Wireless 
Channel of 
Operation 

11 

WEP Security 
Turn on/off  
WEP Security 

Off 

WEP Keys [1-4] Four WEP Keys None 

Key Selection 
Selects the 
WEP Key 

No key 
selected 

 

The terminal supports MAC Address Filtering via the web MMI. 
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ISDN EQUIPMENT 
You can establish ISDN data communication by connecting your ISDN equipment directly to the 
BGAN Terminal’s ISDN port with the supplied ISDN cable (which is the same as the Ethernet 
cable). To activate the ISDN interface, and set MSN numbering options, perform the following 
steps: 

1. From BGAN LaunchPad main menu, select Terminal > ISDN Interface Settings. The Configure 
ISDN Interface dialog box is then displayed, with suggested MSNs set for each ISDN call 
types: 

  

2. Select the Enable Interface check box to activate the ISDN interface, or uncheck the check 
box to deactivate the interface. 

3. For a 4 Kbps speech call, enter MSN 1 into the MSN Speech number: text box. To receive 
incoming calls, you must program the same MSN into your ISDN handset connected to the 
ISDN port. 

4. For a 3.1 KHz audio call , enter MSN 2 into the MSN Audio number: text box. To receive 
incoming calls, you must program the same MSN into your ISDN fax machine connected to 
the ISDN port. 

5. For an Unrestricted Digital Information (UDI) call (64 Kbps ISDN), enter MSN 3 into the MSN UDI 
number: text box. Check the documentation supplied with your ISDN device for details on 
whether it is a UDI device. 

6. For a Restricted Digital Information (RDI) call (56 Kbps ISDN), enter MSN 3 (same as UDI) into 
the MSN RDI number: text box. Check the documentation supplied with your ISDN device for 
details on whether it is an RDI device. 

7. Click OK to save the changes, or Cancel to exit without saving. 
 

Note: You can use MSNs other than the ones above, for any of the ISDN call types. But your ISDN 
equipment must be programmed with the same MSNs to accept incoming calls, and you must 
use different numbers for speech, audio and UDI/RDI calls. Any changes to this screen require a 
re-boot of the terminal to save the new configuration. Use the power button to gracefully power 
down and power back up. 
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 BGAN SERVICES 
 

VOICE TELEPHONY SERVICES 
You can make and receive voice calls using the BGAN Satellite  Terminal. To do this, you have to 
connect a phone handset. You can use two general types of phone handsets; either an ISDN 
handset, or a 2-wire analog handset with an ISDN terminal adapter.  

Before your handset can accept incoming voice calls, you have to program its MSN (mobile 
subscriber number) to the same number as programmed in the terminal (default is 1). This 
ensures that incoming voice calls are directed to your handset. The handset’s instruction manual 
will explain how to do this. Note: you can make emergency calls without the correct MSN 
programmed into the handset. 

 

SUPPLEMENTARY SERVICES 
Supplementary Services have to be provisioned by the Service Provider before they can be 
used. Please verify with your Service Provider which services are available with your subscription. 

You access the Supplementary Services with key-presses on the ISDN terminal. The key-presses 
consist of the following format: 

• A one or two digit activation code 

• A two or three digit service code 

• Optional parameters preceded by a * keypress 

The entry is terminated by a # keypress 

The activation codes use the * and # characters as defined in the following table: 

 

 
The optional parameters are as defined in the following table: 

Parameter Description 
*DN Directory Number 

*T Timeout (5-30 seconds) 

*PW Password 

 

The following table shows all available Supplementary Services: 

Supplementary 
Service 

Description String 

CLIP Calling Line Identification Presentation - Interrogation  *#30# 

CLIR Calling Line Identification Restriction - Interrogation  *#31# 

COLP Connected Line Identification Presentation - 
Interrogation  

*#76# 

Activation Code Description 
**  Registration 

* Activation 
# Deactivation 
*# Interrogation 
## Erasure 
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Supplementary 
Service 

Description String 

COLR Connected Line Identification Restriction - Interrogation  *#77# 

CFU Call Forwarding Unconditional - Registration  **21*DN*# 

CFU Call Forwarding Unconditional - Erasure  ##21*1*# 

CFU Call Forwarding Unconditional - Activation  *21*1*#  

CFU Call Forwarding Unconditional - Deactivation  #21*1*#  

CFU Call Forwarding Unconditional - Interrogation  *#21*1*# 

CFNRc Call Forwarding on Mobile Subscriber Not Reachable - 
Registration  

**62*DN*# 

CFNRc Call Forwarding on Mobile Subscriber Not Reachable - 
Erasure  

##62*1*# 

CFNRc Call Forwarding on Mobile Subscriber Not Reachable - 
Activation  

*62*1*# 

CFNRc Call Forwarding on Mobile Subscriber Not Reachable – 
Deactivation  

#62*1*# 

CFNRc Call Forwarding on Mobile Subscriber Not Reachable - 
Interrogation  

*#62*1*# 

CFB Call Forwarding on Mobile Subscriber Busy - Registration  **67*DN*# 

CFB Call Forwarding on Mobile Subscriber Busy - Erasure  ##67*1*# 

CFB Call Forwarding on Mobile Subscriber Busy - Activation  *67*1*#  

CFB Call Forwarding on Mobile Subscriber Busy - Deactivation  #67*1*#  

CFB Call Forwarding on Mobile Subscriber Busy - Interrogation  *#67*1*#  

CFNRy Call Forwarding on No Reply - Registration  **61*DN**T# 

CFNRy Call Forwarding on No Reply - Erasure  ##61*1*# 

CFNRy Call Forwarding on No Reply - Activation  *61*1*# 

CFNRy Call Forwarding on No Reply - Deactivation  #61*1*# 

CFNRy Call Forwarding on No Reply - Interrogation  *#61*1*# 

CW Call Waiting - Activation  *43# 

CW Call Waiting - Deactivation  #43# 

CW Call Waiting - Interrogation *#43# 

BAOC Barring of All Outgoing Calls - Registration  **33*PW*# 

BAOC Barring of All Outgoing Calls - Activation  *33*PW*# 

BAOC Barring of All Outgoing Calls - Deactivation  #33*PW*# 

BAOC Barring of All Outgoing Calls - Interrogation  *#33*PW*# 

BAIC Barring of All Incoming Calls - Registration  **35*PW*# 

BAIC Barring of All Incoming Calls - Activation  *35*PW*# 

BAIC Barring of All Incoming Calls - Deactivation  #35*PW*# 

BAIC Barring of All Incoming Calls - Interrogation  *#35*PW*# 

BOIC Barring of Outgoing International Calls - Registration  **331*PW*# 
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Supplementary 
Service 

Description String 

BOIC Barring of Outgoing International Calls - Activation  *331*PW*# 

BOIC Barring of Outgoing International Calls - Deactivation  #331*PW*# 

BOIC Barring of Outgoing International Calls - Interrogation  *#331*PW*# 

 

Example:  

If you want to forward all incoming calls to a number (0015554529550 in this example), you must 
activate the Call Forwarding, Unconditional supplementary service. 

§ Format: **21*DN*# 

§ Key-presses: **21*0015554529550*# 
 

If you want to cancel Call Forwarding, you must deactivate this supplementary service. 

§ Key-presses:  #21*1*# 
 

If you want to forward incoming calls to a number (0015554529550 in this example) if they are 
not answered within 20 seconds, you must activate the Call Forwarding on No Reply 
supplementary service. 

§ Format: **61*DN**T# 

§ Key-presses: **61*0015554529550**20# 
 

If you want to cancel Call Forwarding on No Reply, you must deactivate this supplementary 
service. 

§ Key-presses: #61*1*# 
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MESSAGING SERVICES 

SHORT MESSAGE SERVICE (SMS) VIA BGAN LAUNCHPAD 

The BGAN Satellite Terminal supports Short Message Service (SMS) capabilities. The Short 
Message Service handles point-to-point messages, and SMS messages to can be sent from the 
terminal, and received by the terminal. 

The text messages can contain up to 160 ASCII characters. The amount of data actually 
transmitted with an SMS message is dependent on the message size. 

þ 
Note 

SMS Messages can be read, edited, created, and sent via the SMS Application in 
the BGAN LaunchPad. You cannot access SMS from an ISDN Handset or any other 
ISDN equipment. 

 

The configuration screen for Text Messages can be accessed from the Settings Pull Down menu 
of the Text screen. To be able to send text messages you need to have the SMS service center 
configured with the following number: +870772001799. 
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DATA SERVICES 
LaunchPad provides a variety of connection options to help ensure that all your data 
requirements are met. LaunchPad is configured with five connections by default. You can edit 
these default connections or add to them by setting up any number of customized connections, 
called dedicated connections, using a configuration tool. 

DEFAULT CONNECTIONS 

The five default types of data connections consist of one standard and four streaming types. 

n Standard : A standard connection is charged per Mb. You are charged only for the amount 
of data that is sent. The bandwidth you are allocated depends on terminal type and 
network availability, but is always ‘best effort’, that is, you are allocated bandwidth 
depending on your requirements and the requirements of other users of the BGAN network, 
or BGAN Terminal. This connection class is suitable for most data types, other than 
multimedia. 

n Streaming: A streaming connection is charged by time. You are charged for the amount of 
time the connection is active. Streaming enables multimedia data, such as video, to be sent 
in a continuous data stream and converted into sound and pictures. The bandwidth 
required for a streaming connection is difficult to predict, and depends on factors such as 
length of connection and number of receivers. 

The standard connection is suitable for most basic data requirements, and is charged by the 
amount of data sent. If you require a guaranteed data rate for your connection, to eliminate 
delay for example, you can connect using one of the four streaming connections, at the 
following data rates: 

n 32 Kbps streaming 

n 64 Kbps streaming 

n 128 Kbps streaming 

n 256 Kbps streaming 
 

Each streaming class connection is charged by the length of time that the connection is live. 

The standard connection and four streaming connections are primary connections and are 
alternatives to each other, that is only one can be open at a time. You must close one 
connection before you can open another. This is per TE. Each TE can have its own primary PDP 
context (e.g. background or streaming connection) and up to 11 TE’s may be connected to 
one UT at a time. Each TE will have a separate global IP address to the network. 
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DEDICATED STREAMING CONNECTIONS 

If required, you can set up one or more dedicated streaming connections for applications such 
as live video and FTP using only one TE. A dedicated streaming connection ensures that a 
selected application does not have to share the connection with any other traffic from that 
same TE. The Terminal supports up to ten dedicated connections alongside the primary 
connection through the use of Traffic Flow templates (TFT’s). A dedicated streaming connection 
is charged by the length of time that the connection is live.  

LaunchPad displays an information note if you are about to open a streaming connection, or 
open two or more connections at the same time. Refer to About PDP Contexts for details on 
how LaunchPad manages data connections. 

VPNS 

If you require extra security when transmitting data, you can add a VPN connection to 
LaunchPad, and use this connection to run a VPN application on your computer. When your 
VPN connection is open and the VPN application is running, communications between 
LaunchPad and the Terminal are closed down. Therefore, when a VPN connection is open, 
information about the Terminal does not display on the LaunchPad status bar. 

ISDN DATA 

Data can be sent and received via the ISDN interface on the BGAN IP Terminal. To make use of 
this service, you will need to connect an appropriate ISDN terminal equipment. Examples of ISDN 
equipment are ISDN cards in PCs or MACs, ISDN Audio/Video cameras and video-conferencing 
systems, ISDN group 4 fax machines. 

To accept incoming calls, you first have to program the ISDN terminal with the same MSN as is 
programmed in the satellite terminal for that call type. The MSNs are pre-set in the terminal to be 
2 for 3.1KHz audio, and 3 for UDI/RDI data, but any number can be programmed. It is important 
that for each call type, the MSNs programmed in the terminal and the ISDN equipment match 
to ensure that incoming calls can be accepted. To re-program the terminal MSN numbers to 
match the ISDN device, go to LP>Terminal ISDN Interface. Any changes to this screen require the 
terminal to be re-booted prior to the changes taking effect. 

  

Refer to the instructions supplied with the ISDN equipment for information on the equipment 
capability, the type of call that it uses, and how to program the appropriate MSN. 
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OPENING DATA CONNECTIONS  

Data connections can be opened, added and managed from the Data Connections tab. To 
open the Data Connections tab, click on the Data icon in launch bar. The Data Connections 
tab opens, as shown below: 

 

From this window, you can do the following: 

Open and Close Connections 

n Open a Data Connection 

n Close a Data Connection 

n Open a VPN − only available if you have configured a VPN. Refer to Add a VPN for details. 

n Close a VPN − only available if you have configured a VPN. 

Add a Dedicated Streaming Connection 

n Add a Data Connection 

Add a VPN 

n Add a VPN 

Manage Connections 

n View Data Connections 

n Delete a Data Connection 

n Change the icon order 

n Hide an icon 

OPENING AND CLOSING A CONNECTION 

OPENING A DATA CONNECTION 

To open a data connection, click on the Data icon in the launch bar to open the Data 
Connections tab. All the available data connections are displayed. You can select one primary 
connection, and as many secondary or dedicated connections as you require. 

OPENING A STANDARD CONNECTION 

To open the standard connection: 

If a primary Streaming connection is open, close this connection by clicking on the Streaming 
connection icon. The message The Primary PDP context has been closed displays. Click on 
OK to close this dialog box. 
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In the Data Connections window , click on the Standard connection icon. The message Primary 
PDP Context has been established successfully displays. 

Click on OK to continue. 

OPENING A STREAMING CONNECTION 

To open a primary streaming connection: 

1. If the standard connection is open, close this connection by clicking on the Standard 
connection icon. The message The Primary PDP context has been closed displays. Click on 
OK to close this dialog box. 

2. In the Data Connections window , click on a Streaming connection icon. The following dialog 
box displays: 

 
 

3. Click on Yes to open the Premium connection. The message Primary PDP Context has been 
established successfully displays. 

4. Click on OK to continue. 

To close a data connection: 

5. You can close any connection that is currently open by clicking on the appropriate icon.  

6. Alternatively, click on View all data connection on terminal, and then click on the close 
button next to the connection you want to close. 
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OPENING A DEDICATED STREAMING CONNECTION 
To open a dedicated streaming connection: 

1. Click on the Dedicated connection icon that you want to open. The following dialog box 
displays: 

  
2. Click on OK to continue. This opens a dedicated connection alongside your current primary 

connection. You can open as many dedicated connections as you require, in this way. But 
the total number of primary and dedicated data connections open on the terminal cannot 
exceed 11. 

CLOSING A DATA CONNECTION 

To close a data connection, do any of the following: 

n Click on the connection in the Data Connections tab. The connection icon loses its outline, 
indicating that the connection is closed. 

n In the Data Connections tab, click on the View all data connections in terminal button to 
display the BGAN Connections window. You can then click on Disconnect to close the 
appropriate connection.  

n In the LaunchPad main menu, select BGAN Services > Close All Data Connections. The Close 
all satellite connections dialog box displays, where you have the option to select Close All 
My Data Connections or Close all Data Connections for All Users. 

Note: If you are sharing the BGAN Terminal, clicking on Close All Data Connections for All 
Users closes the connections of other Terminal users. 

SET UP OR EDIT A VPN CONNECTION 

A VPN connection differs from other data connections in that only the VPN connection can be 
open when a VPN application is running. LaunchPad closes all other functionality related to the 
Terminal while a VPN connection is open and a VPN application is running. For this reason, you 
must carefully select when to open a VPN connection, so that other operations are not 
affected. 

To configure a VPN icon and VPN icon name, and launch an application with the VPN icon: 

1. Click on the Data icon in the launch bar to display the Data Connections tab. 

2. Click on Advanced to display the Connection Configuration window. 

3. Click on Add New Connection to display the connection configuration screen. 

4. Select Create new VPN IP Data Connection and click OK. 
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5. Type in a name for the VPN connection in the Icon label text box. The name and icon that 
you select here will display when you open the Data tab in LaunchPad. 

6. You can now configure the VPN Connection Quality and Routing Options. The way to do this 
is identical to other data connections. For full details, see Configuring Connection Quality 
and Setting Up Routing Options in the Adding Or Editing A Dedicated Connection section 
below. 

7. Click on Apply to save the displayed configuration, and continue editing the connection, 
click on OK to save the displayed configuration and exit the configuration screens, or click 
on Cancel to exit without saving. 
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OPENING A VPN 

To open a VPN connection and run a VPN application: 

Click on the VPN icon in the Data Connections window.  

1. Click on OK to continue. This opens the VPN connection ready for you to open a VPN 
application, and closes all other connections. Note the following: 

§ All other data connections remain unavailable until you close the VPN application and 
the VPN connection.  

§ The Status section of the status bar indicates that there is No Open Connection, and the 
Connected to and Signal strength sections of the status bar do not display any Terminal 
information. 

§ Launch Pad closes all other functionality related to the Terminal whilst the VPN 
application and VPN connection is open. 

2. Open the VPN application on your computer. 

Note: If you selected a VPN application when Setting Up an Icon , this application 
automatically launches when you open the VPN connection.  

CLOSING A VPN 

A VPN differs from other data connections in that the LaunchPad closes the interface with the 
Terminal whilst the VPN connection is open and the VPN application is running. For this reason, 
you must close your VPN application and reconnect to the Terminal when you want to return to 
normal LaunchPad functionality. 

To close a VPN: 

1. Close the VPN application on your computer. 

2. In the LaunchPad status bar, click on Search for BGAN Terminal . The LaunchPad closes the 
VPN connection, re-connects to the Terminal, and opens a standard data connection. The 
process is the same as if the Terminal was Registering with the Network for the first time. 

You can now use all LaunchPad features. 
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ADDING OR EDITING A DEDICATED CONNECTION 

SETTING UP AN ICON 

To configure an icon and icon name, and launch an application with the icon: 

1. Click on the Data icon in the launch bar to display the Data Connections tab. 

2. Click on Advanced to display the Connection Configuration  window. 

3. Click on Add New Connection if you want to set up a new connection, then select Create 
new Dedicated Streaming IP Data connection  and click OK, or select a connection icon and 
click on Edit if you want to edit an existing connection. The Dedicated Connection window 
displays. 

 

4. Select an icon. The icon displays in the box next to the Icon label  text box. 

5. Type in a name for the connection in the Icon label text box. The name and icon that you 
select here will display when you open the Data tab in LaunchPad. 

6. Select the Application Traffic Flow Template for the dedicated connection from the list. 

7. Select the desired and minimum streaming data rate for this connection. 

8. Check the Use error correction check box if you want to turn error correction on. 
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9. Click on Apply to save the displayed configuration, and continue editing the connection, 
click on OK to save the displayed configuration and exit the configuration screen, or click on 
Cancel to exit without saving. 

10.  

CONFIGURING CONNECTION QUALITY 

To configure the Connection quality for a data connection: 

1. Either: 

§ From the LaunchPad Data Screen, right-click the icon you want to edit,  

Or: 

§ From the LaunchPad Data Screen, click on Advanced, select the icon you want to edit 
and click on Edit. 

Or: 

§ To create a new connection: From the LaunchPad Data Screen, click on Advanced, then 
click on Add new Connection, select Create new Standard IP or Streaming IP Data 
Connection and click OK.  

 

2. Enter a name for the connection in the field next to Icon label: 

3. Select a Connection class. This can be either Standard or Streaming. 

§ If you choose Streaming, the Streaming Parameters section of the window activates. 

4. If you choose Streaming you can do the following in the Streaming Parameters section of the 
window:  

§ Select the Desired Symmetrical Rate from the drop-down list.  

§ Select the Minimum Symmetrical Rate from the drop-down list. 

§ Check the Use error correction check box if you want to turn error correction on. 

5. Edit the routing options for this connection: 

§ Select an APN from the Select APN drop-down list. If it is not activated, only the default 
APN is available. 
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§ In the IP Configuration section, set up your IP Address requirements. Select either Use 
Dynamic (Network Assigned IP Address) or Use Static IP Address. If you select Use Static IP 
Address, enter the IP Address in the text box. You can get a static IP address from your 
Service Provider. 

§ In the IP Configuration section, set up your DNS Server requirements. Select either Use 
Dynamic (Network Assigned) DNS Servers or Use Static DNS Server. If you select Use Static 
DNS Server, enter a Primary DNS Server and, if required, a Secondary DNS Server in the 
text box.  

§ If required, check the Use Header compression check box to turn on header 
compression. 

6. Click on Apply to save the displayed configuration, and continue editing the connection, 
click on OK to save the displayed configuration and exit the configuration screens, or click 
on Cancel to exit without saving. 
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MANAGING ISDN CONNECTIONS 

OPENING AN ISDN DATA CONNECTION 

Data can be sent and received via the ISDN interface on the Terminal. To make use of this 
service, you must connect an ISDN device to the Terminal. Examples of ISDN devices are ISDN 
cards in PCs or MACs, ISDN AudioVideo cameras and ISDN fax machines. 

To use the ISDN device with the Terminal: 

1. Program an MSN (Mobile Subscriber Number) into the device. The number you use depends 
on the capability of your ISDN device. 

§ If the device sends and receives data as 3.1KHz audio, such as Group 3 fax machines, use 
MSN 2. 

§ The device sends and receives data as Unrestricted Digital Information (UDI) or as 
Restricted Digital Information (RDI), use MSN 3. 

Refer to the instructions supplied with your ISDN device for information on its capability, and 
how to program the appropriate MSN. 

2. Make sure that the ISDN interface is set up in LaunchPad. Refer to Setting up the ISDN 
Interface for details. 

3. Connect the ISDN device to the ISDN connector on the BGAN Terminal.  
 

You are now ready to access ISDN Data Services. 
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 SERVICE FEATURES 
 

AUTOMATIC MODE 
The Satellite Terminal includes four automatic options: auto power on, LED on/off, antenna 
pointing bypass, and automatic context activation. You can set all of these options with the 
BGAN LaunchPad. The terminal also has an Automatic Context Activation feature that can be 
used without the need for LaunchPad. 

AUTO “ON” MODE 

When the Satellite Terminal is mounted on a pole, the power button may be inaccessible. This 
can be a problem if there is a power failure since the unit will turn off and will not turn back on 
when power is applied. You could use the unit with a battery to provide battery backup in case 
of power failure. However, at extreme temperatures a battery could be damaged and should 
not be used.  

To solve this problem, you can activate the terminal’s auto on feature. With auto on enabled, if 
a power adaptor is connected, the terminal turns on as if the power button was pressed.  The 
terminal can still be powered off by pressing the power button with this feature enabled. The 
terminal can be powered on by reconnecting the AC or DC power adaptor, or pressing the 
power button. The default configuration of the terminal is for auto on to be enabled. 

The auto on feature can be used in conjunction with antenna pointing bypass to allow the 
Satellite Terminal to automatically recover from a power outage (assuming PIN, etc are 
disabled). 

LED ON/OFF MODE 

In a semi-fixed installation, you can use this option to operate with all LEDs off to make your unit 
and operation less conspicuous. 

ANTENNA POINTING BYPASS 

You can configure a pointing bypass option that causes the unit to skip the pointing phase. The 
unit then performs spot beam selection, registration and network connection. This option should 
only be used for fixed installations where pointing is not required on subsequent power ups. With 
this option active, if the unit is moved or the signal attenuated, the unit will remain in global 
beam scan until the problem is fixed and the global beam acquired. After acquiring the global 
beam the Satellite Terminal automatically continues with PSAB acquisition. 

AUTOMATIC CONTEXT ACTIVATION 

If you have enabled automatic context activation, the Satellite Terminal automatically activates 
a PDP context when it exits antenna pointing and registers with the network.  

The “context create” request uses the default Access Point Name (APN), username and 
password stored in the Satellite Terminal. You can modify these parameters using the BGAN 
LaunchPad. “Subscribed” QoS is requested and a dynamic network assigned IP address 
requested (“global” address). 

AUTOMATIC CONTEXT ACTIVATION WITHOUT LAUNCHPAD 
Automatic Context Activation is a configuration option which specifies whether the UT should 
automatically activate a PDP context after the UT is pointed and registered with the BGAN 
network.   
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FRONT PANEL LED INDICATORS 
The Automatic Context Activation feature will make use of the front panel LED’s to give visual 
feedback to the user what the context status is for each QoS. The position of the LED indicates 
the type of service as shown in the figure below: 
 

 
 
Blinking Green LED: 
The UT is currently trying to establish a PDP context with the desired QoS. 
 
Solid Green LED 
The UT currently has at least one PDP context using this QoS. 
 
Blinking Red LED 
The UT failed to establish a PDP context using the desired QoS, but it is retrying. 
 
Solid Red LED 
The UT failed to establish a PDP context using the desired QoS. 
 
If a second TE attempts to establish a connection for a context with the same QoS as an already 
established context, there will be no change to the front panel LED, i.e. it will remain solid green. 
 

LAUNCHPAD “AUTOMATIC CONNECTION MODE” DESCRIPTION 
The Inmarsat LaunchPad application controls ACA via a feature called “Automatic Connection 
Mode” that can be found by going to the “Terminal” tab and selecting automatic connection 
mode. This is the same feature as Dynamic Background ACA on the ACA web page. It is used to 
automatically establish a background PDP Context for any TE that connects to the 9201.  
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USIM  APN MODE VS. MANUAL APN MODE 
The ACA feature supports two different modes; USIM APN mode and Manual APN mode. These 
two modes are supported across all IP Address Ranges for all QoS assignments. 
 
Note: When a UT is upgraded to version 3.6.1.0, the UT is reconfigured to delete any APN 
information that has been configured, including Username and Password. 
 

USIM  APN MODE (DEFAULT) 
USIM APN Mode is used if Automatic Context Activation is enabled and the user has not defined 
a specific APN to be used. If no APN is defined, the UT will read the APN name directly from the 
USIM when attempting to establish a PDP context. 
 
If a user wishes to enable the Automatic Context Activation feature for any device that is 
connected to the UT, the feature need s to be enabled via the UT Web Server or via AT-
commands.  
 

MANUAL APN MODE 
Manual APN Mode is used if Automatic Context Activation is enabled and the user has defined 
a specific APN to be used. If an APN is defined, the UT will use that APN when attempting to 
establish a PDP context. 
 
If the APN requires a username and password to successfully establish a PDP context, it must be 
defined as well. 
 
If a user wishes to enable the Automatic Context Activation feature for any device that is 
connected to the UT, the feature needs to be enabled via LaunchPad,  UT Web Server or via AT-
commands.  

CONFIGURING THE ACA FEATURE 
In order to use the ACA feature, it must be activated by either the Inmarsat LaunchPad, the UT 
Web Server or the AT-Command interface. 
 

CONFIGURATION VIA LAUNCHPAD 

Under the Terminal options, select Automatic Connection Mode. By activating the checkbox, 
the user will be able to choose the desired APN. 
 
Note:  
LaunchPad allows the user to define the APN, along with any required username and password 
under BGAN Services. After the APN has been defined, it will be available for configuring UT 
Automatic Connection Mode. 
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Version 3.2.1 and earlier versions of LaunchPad don’t support activating the Automatic Context 
Activation feature without defining an APN. To use the USIM APN Mode, the UT Web Server or AT-
commands must be used for configuration. 
 

CONFIGURATION VIA UT WEB SERVER 
The Hughes 9201 SW releases 3.6.1.5 and later include a built-in Web Server. To access the UT 
Web Server, access the UT IP address with your favorite Web Browser, e.g. http://192.168.128.100. 
See the section Using the section “Using the Hughes Web MMI” for further instructions. 
 

DNS SERVER 
The Hughes 9201 supports automatic or manual DNS server address assignment.  

DNS SERVER – AUTOMATIC MODE 

To use automatic assignment of DNS addresses to your TE, set the Primary and the Secondary 
DNS server addresses to 0.0.0.0. Important: both addresses must be set to 0.0.0.0 to activate this 
feature. 
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In automatic mode the terminal will assign the DNS server addresses obtained from the network 
when an IP Data Connection is established. 

 

DNS SERVER – MANUAL MODE 

To use manual assignment of DNS addresses to your TE, program the desired DNS server 
addresses in the Configure Local LAN dialog box. These addresses will be assigned to the TE 
during initial connection of the TE to the terminal. Note that the TE must be configured to 
dynamically obtain an IP address through DHCP to obtain DNS server addresses from the 
terminal. 

 

 

 

PHONEBOOK 
BGAN supports a phonebook feature to facilitate the management of phone numbers.  

The phonebook is stored on the USIM, and can have up to 250 entries. The phonebook can also 
be saved as a file to your computer, and your computer can also load phonebook entries from 
this file back to the USIM. 

 

EMERGENCY CALLS 
You can make emergency calls with an ISDN handset, or an analog handset plus ISDN terminal 
adapter connected to the terminal. You must have exited pointing, and you do not need to 
have a USIM in the terminal. 
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PDP CONTEXTS OVERVIEW 

PDP CONTEXTS – PRIMARY AND SECONDARY 

Resource management for BGAN is based on PDP contexts, or connections. This means that in 
congested networks each user needs his or her own context to ensure a fair allocation of 
bandwidth from the network. Therefore, the Satellite Terminal creates a PDP context for each 
connected computer that has traffic to send over the network. The multiple contexts can be 
primary or secondary. 

n Primary contexts can connect to different APNs each with an individual username and 
password. This is useful because each APN will only support a single set of subscribed Quality 
of Service (QoS) values. 

n Primary contexts each get their own global IP address. 

The total number of primary and secondary contexts that the Satellite Terminal can support is 11. 
For example, it can support 5 primary and 6 secondary contexts, but not six primary and 6 
secondary contexts. There is only a single primary context assigned to each computer 
connected to the Satellite Terminal. 

You can configure the Satellite Terminal to enable or disable automatic context activation. Even 
if automatic context activation is used, you can still manually control contexts for flexibility and 
exception conditions. 

Primary Context 

The Satellite Terminal creates a primary context with the entered information. If a primary 
context already exists for your local IP address, you have to disconnect the current context 
before creating the new one. This could happen if a context was created automatically and the 
user wants to change to a different APN or QoS. Your BGAN LaunchPad indicates whether the 
context is successfully created or displays any errors. LaunchPad also allows you to disconnect 
any contexts.  

Secondary Context 

Secondary contexts can be set-up from the BGAN LaunchPad, and must always be associated 
with an existing primary context. Secondary contexts are used when multiple applications on 
your computer require different types of contexts. 

Each secondary contexts requires a Traffic Flow Template to be configured, which defines how 
the data for the secondary context should be routed. This is done through the BGAN 
LaunchPad. 

IP ADDRESSING 

Connections between each TE and the terminal are achieved with private IP addresses, and 
between the terminal and the BGAN network with global addresses. 

Private addresses are dynamically assigned by the DHCP server in the terminal, starting 
from192.168.128.101 and up to 192.168.128.199 if the TE is configured to obtain an IP address 
automatically.  

You can also manually configure the IP address of the TE with the operating system’s 
administrative tools. See the Automatic Context Section for the range of static and dynamic 
addresses that can be used. 

The global address of the terminal is assigned by the Network Service Provider, and can be 
either static or dynamic.  Dynamic global address configuration is automatically carried out by 
the mechanism in the terminal that activates contexts. Static global addresses must be setup 
with your Network Service Provider in advance. 

The local IP address of the terminal can be modified for special applications using the web 
server of the terminal. To access the web server, open an Internet browser and type in 
http://192.168.128.100 in the URL address field. To access the local IP address of the terminal 
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Click on Setup. Change the last octet (e.g. 192.168.128.xxx) and click on Apply. You must re-
boot the terminal for the change to take affect. 

 

MULTIPLE USERS 
Up to 11 computers can be connected to the BGAN terminal using the Ethernet, WLAN and USB 
interfaces. 

More than one TE can be connected to the Ethernet interface by using either a hub, router or a 
switch. If a hub is used, the BGAN terminal will allocate private IP addresses to each TE 
connected to the hub, and so each TE will be able to have a primary PDP context. If a router 
(which includes a NAT) is used, the whole private network would appear as a single device to 
the BGAN terminal, and so the TEs connected to the router will share a single primary PDP 
context. The NAT in the router would assign IP addresses within its own subnet. 

Multiple computers connected via the WLAN interface will each be allocated a private IP 
address. 

 

MANAGING CONTACTS 
The Contacts window enables you to manage your Phone and Text contacts. You can add a 
new contact, edit or delete an existing contact. In addition, you can exported a contact to a 
file on your computer, or import a contact from any file on the computer.  

The Contacts screen shown below displays when you click on the Phone icon or the Text icon on 
the launch bar. 

 

Contacts are stored in the BGAN SIM. 

From this window you can: 

n Create or Add a New Contact 

n Edit a Contact 

n Export a Contact to a File 

n Import a Contact from a File 
 

Click on a contact name in the Contacts column to display the details of the contact alongside.  

You can also search for a contact by typing in the first few letters of the contact name in the 
Search text box, and then click on Go. The Contacts list then shows only the entries which match 
the search text. Click on All to display all contacts again. 
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ADDING AND EDITING CONTACTS 

This section explains how to add, edit or delete a contact. 
 

ADDING A CONTACT 

To add a contact to an address book: 

1. Click on New in the Contacts window. The following screen displays: 

 

2. Enter the name of the contact on the first line. 

3. Enter the contact number at the Number: prompt. 

4. Click on Save to save the contact details. 
 

EDITING A CONTACT 

To edit an existing contact: 

1. Select the contact to be edited and click on Edit. The following screen displays: 

 

2. Edit the name or the contact number of the contact. 

3. Click on Save to save the contact details. 
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DELETING A CONTACT 

To delete a contact:  

1. Select one or multiple contact from the Contacts list.  

2. Click on Delete. You are asked to confirm the deletion. 

3. Click on Yes to confirm, or No to return to the Contacts window. 

EXPORTING AND IMPORTING CONTACTS 

This section explains how to export a contact to a file on your computer, and import a contact 
from a file on your computer. 

EXPORTING A CONTACT 

You can export a contact or contacts to a file on your computer.  

To export a contact to a file: 

1. Select the contact to be exported and click on Export. The Choose Export Type dialog box 
displays, as shown below: 

 
2. Check the File check box to export the contact to a file on your computer.  

3. Click on Continue. 

4. The Save dialog box displays. Navigate through your computer’s file structure using this 
window , and click Save to save the contact details. 
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IMPORTING A CONTACT 

You can import a contact from a file on your computer. To do this: 

1. Click on Import. The Open dialog box displays. 

2. Navigate through your computer’s file structure using this window, and click Open to select 
the contact details you want to import. The Select Address Book  dialog box displays, as 
shown below: 

 
3. Check the BGAN SIM check box to import the contact to the BGAN SIM. 

4. Click OK to import. 
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TCP PEP SOFTWARE 
Transmission Control Protocol (TCP) enables two hosts, usually computers to establish a 
connection and exchange data. It improves the efficiency of data transfer by dividing the data 
into packets, then delivering the packets in the same order that they were sent. 

TCP with Performance Enhancing Proxies (TCP PEP) enhances the performance of TCP over a 
satellite network such as the BGAN network by providing: 

n Fast start − useful for transferring small amounts of data, since traditional TCP is often slow with 
smaller data transfers. 

n Increased window size − improves TCP performance in larger bandwidth applications. 

n Delay based congestion control  − ensures high transfer rates and less delay. 
 

TCP PEP is automatically installed during the Standard installation of LaunchPad, or you can 
install TCP PEP separately from the installation CD. 

You can enable or disable TCP PEP, and monitor any errors, using the TCP Accelerator screen.  

n From BGAN Launch Pad main menu, select BGAN Services > TCP Accelerator. The TCP 
Accelerator screen is then displayed.  To turn on TCP PEP select “ON” from the drop down in 
the TCP PEP State and then hit “Apply”. 
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EXIT, RESET AND RESTART FEATURES 

EXITING LAUNCHPAD 

You can exit LaunchPad and leave any active connections open. Refer to Closing a Data 
Connection or Closing a Connection in Multi-User Mode for details. 

Exit LaunchPad as follows: 

1. Click File > Exit BGAN LaunchPad. The Shutdown Confirmation dialog box displays: 

  

2. Click Yes to confirm shutdown, or No to cancel. 

RESETTING THE TERMINAL 

If you have the required access privileges, you can reset all the configuration settings of the 
Terminal to the factory default. Note that your current settings are lost during the reset. 

Note: This will delete all “User” Parameters that have been previously setup (WLAN, DNS, User 
name and password, etc.) 

To reset the terminal to factory default: 

Select the Terminal > Reset to Factory Default option on LaunchPad main menu. The Reset to 
Factory Default dialog box displays, as shown below: 

  

3. Enter the security code in the Security Code text box. The security code is “broadband’ 
(lowercase) 

4. Click on OK to reset the terminal, or click on Cancel to exit without resetting. 

RESTARTING THE TERMINAL 

You may want to restart the terminal if an error occurs.  

To restart the terminal: 

1. Select Terminal > Restart Terminal  from the LaunchPad main menu. The Restart BGAN 
Terminal dialog box displays, as shown below: 
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2. Click on OK to restart the terminal, or click on Cancel to exit without restarting. 

 

GETTING HELP 
Support for the BGAN Satellite Terminal is provided via the following help options: 

n Using Services 

n Using Support 

n Using Diagnostics 

n Using LaunchPad Help and QuickStart wizard 

n Viewing Properties 

 
 
 

BGAN PROFILE MANAGER 

ABOUT PROFILE MANAGER 

Note: The Profile Manager is only available to users of the Corporate Edition of LaunchPad. 

The Profile Manager enables the BGAN LaunchPad Administrator to create and edit user profiles, 
and so customize BGAN LaunchPad to your organization's requirements. Using the Profile 
Manager, you can quickly and easily configure connections, apply user restrictions and set up 
the customer support details available from within BGAN LaunchPad. This enables you to 
manage the functionality of BGAN LaunchPad, and gives you more control over how BGAN 
LaunchPad is used.  

Note the following about the Profile Manager: 

n You can configure and create user profiles for use either on a standalone PC, or across a 
network of users. 

n You can create an unlimited number of user profiles.  

n All user profiles are held in the Profile Manager Image Library, stored on a network-shared 
drive of the computer. 

Profile Manager is installed automatically when you install the Corporate Edition of BGAN 
LaunchPad. Refer to Installing Corporate Edition for details. 
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CREATING AND EDITING A PROFILE 

CONFIGURING A PROFILE 

When you open the Profile Manager, the General tab is active, and the default profile is 
displayed, as shown below: 

 

Note the following when creating or editing a connection: 

n If at any time you want to clear all the existing settings for a profile, click on the File menu, 
and select New. You will be asked to confirm the operation. Click Yes to confirm. 

n You must go into each of the tabs in Profile Manager, and complete all mandatory fields, 
before you can save the profile. 

n When you first open Profile Manager, any default profile is displayed. 
 

To create a connection: 

1. Configure a Connection. 

2. Configure Restrictions. 

3. Configure Support Details. 

4. Configure User Information. 
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CONFIGURING A CONNECTION 

This section describes how to set up a connection. To do this: 

1. In Profile Manager, select the Connections tab. The Connections screen displays, as shown 
below: 
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2. Either: 

§ To add a new connection, click on Add new connection. Or: 

§ To edit an existing connection, select the icon that you want to edit, and click on Edit 
configuration. Or: 

§ To add a VPN, click on Add new VPN. 

The Connection icon setup screen displays, as shown below: 

 

The Connection icon setup window has three components, as follows: 

§ Icon 

§ Connection Quality 

§ Routing 

CONFIGURING AN ICON 

To configure an icon: 

1. Select an icon. The icon displays in the box next to the icon label text box. 

2. Type in a name for the connection in the icon label text box. The name and icon that you 
select here will display when you open the Data tab in BGAN LaunchPad. 

3. Check Launch Application on selection check box to launch a particular application when 
you click on this icon in BGAN LaunchPad. For example, you may want to launch Internet 
Explorer when you select this icon. 

4. Use the Browse button to search for the file name of the application you want to launch with 
this icon (or if you know the file name, enter it in the Path text box). When you open this 
connection in BGAN LaunchPad, the application automatically opens. You must close the 
application before you can close this connection. 
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5. Click on Apply to save the displayed configuration, and continue editing the connection, 
click on OK to save the displayed configuration and exit the configuration screens, or click on 
Cancel to edit without saving. 
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CONFIGURING CONNECTION QUALITY 

To configure the Connection quality for a data connection: 

From the Connection Icon Setup window, click on the Connection quality tab. The Connection 
Icon Setup - Connection quality window displays, as shown below: 

 

1. Select a Connection class. This can be either Standard, Streaming or Dedicated. Note that 
Dedicated does not display if you are configuring a VPN. 

§ If you chose Standard, no further configuration is required in this window. 

§ If you choose Streaming, the Streaming Parameters section of the window activates. 

§ If you choose Dedicated, the Application template drop-down list and the Streaming 
Parameters section of the window activates. 

2. If you choose Streaming or Dedicated, you can do the following in the Streaming 
Parameters section of the window:  

§ Select the Desired Symmetrical Rate from the drop-down list.  

§ Select the Minimum Symmetrical Rate from the drop-down list. 

§ Check the Use error correction check box if you want to turn error correction on. 

3. If you choose Dedicated, select an application template (also known as a traffic flow 
template) from the Application template drop-down list. This associates an application with 
this connection, and enables the Terminal to correctly route certain types of traffic. For 
example, if you want the traffic from a selected FTP application be routed through this 
dedicated connection, select the FTP template from the drop-down list.  

4. Click on Apply to save the displayed configuration, and continue editing the connection, 
click on OK to save the displayed configuration and exit the configuration screens, or click 
on Cancel to edit without saving. 



 

98 BGAN 9201 User Manual 

CONFIGURING ROUTING OPTIONS 

To configure the Routing options for a data connection: 

From the Connection Icon Setup window, click on the Routing tab. The Connection Icon Setup - 
Routing window displays, as shown below: 

 

1. If the drop-down box is activated, select an APN from the Select APN drop-down list. If it is 
not activated, only the default APN is available. 

2. In the IP Configuration section, set up your IP Address requirements. Select either Use 
Dynamic (Network Assigned IP Address) or Use Static IP Address. If you select Use Static IP 
Address, enter the IP Address in the text box. You can get a static IP address from your 
Service Provider. 

3. In the IP Configuration section, set up your DNS Server requirements. Select either Use 
Dynamic (Network Assigned) DNS Servers or Use Static DNS Server. If you select Use Static 
DNS Server, enter a Primary DNS Server and, if required, a Secondary DNS Server in the text 
box.  

4. If required, check the Use Header compression  check box to turn on header compression. 

5. If required, check the Use VPN with this connection check box, and select a VPN from the 
drop-down list. 
 
Note: This option does not display if you are configuring a VPN connection using Profile 
Manager. 

6. Click on Apply to save the displayed configuration, and continue editing the connection, 
click on OK to save the displayed configuration and exit the configuration screens, or click 
on Cancel to edit without saving. 
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CONFIGURING RESTRICTIONS 

Using the Settings tab, you can set restrictions on the selected profile. 

To set restrictions: 

1. Click on the Settings tab. The Settings screen displays, as shown below: 

 

2. Select one of the radio buttons. The options are as follows: 

§ No restriction  – the BGAN LaunchPad user can change the connection and BGAN device 
settings. 

§ Medium restriction  – the BGAN LaunchPad user cannot change connection settings, but 
can change BGAN device settings. 

§ Maximum restriction – the BGAN LaunchPad user cannot change connection settings or 
BGAN device settings. 

3. If required, check the Disable control of all open connections in a device check box. The 
ensures that users cannot edit connections owned by other users. 

4. Click Save to save the displayed configuration and exit from the Settings window. 
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CONFIGURING SUPPORT DETAILS  

Using the Support tab, you can set the Support contact details that will display on BGAN Launch 
Pad. 

To set support details: 

1. Click on the Support tab. The Support window displays, as shown below: 

 

2. Either: 

§ If no user support is available, click on the No user support available check box, or, 

§ Enter the details of the available user support in the Email, Website and Telephone 
number text boxes. If one of these options is not available, click the appropriate None 
Available check box. 

3. Click Save to save the displayed configuration and exit from the Support window. 
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CONFIGURING USER INFORMATION 

After you have completed all screens in the Profile Manager and clicked on Save, the User 
Information window displays, as shown below: 

 

This window enables you to create a user login for use with this profile, or to create multiple 
profiles with different user logins. 

To create a user login for the current profile: 

1. Type a user name in the User name text box. 

2. Type a password in the Password text box. 

Either: 

§ If you only require one user login for this profile, click Save. A dialog box opens enabling 
you to save the login in a selected directory; or 

§ If you want to add in additional profiles with different user logins, click the Create multiple 
different images with different user names and passwords check box. An Add button 
displays beneath the Password text box. 

3. Click Add. The user login displays in the login table. 

4. Repeat steps 1, 2 and 4 for each additional profile you want to create. 

5. Click Save when you have created all required logins. A dialog box open enabling you to 
save the logins in a selected directory. 

IMPORTING A USER LOGIN 

If required, you can import a user login. 

To import a user login, in the User information window: 

1. Click on Import. The Open dialog box displays. 

2. Navigate to the directory where the profile is stored, select the required login and click 
Open.  

3. The user login is imported into the login table. 
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EXPORTING A USER LOGIN 

If required, you can export a user login. 

To export a user login, in the User information window: 

1. Click on the user login you want to export, and click Export. The Save dialog box displays. 

2. Navigate to the required directory, and click Save. 

MANAGING PROFILES 

CHANGING THE ICON ORDER 

The available data connections display in the BGAN LaunchPad Data connections window. You 
can change the sequence in which the icons displays using Profile Manager. 

To change the icon sequence: 

1. In Profile Manager, click on the Connections tab. 

2. Select an icon you want to move, and use the Move Left and Move Right buttons to move 
the icon to its new position in the sequence. 
Note: If you want to move an icon more then one place to the right or left, you must select 
the icon each time before using the arrow keys. 

3. If required, repeat step 2 for any other icon you want to move. 

DELETING A DATA CONNECTION 

To delete a connection: 

1. In Profile Manager, click on the Connections tab. 

2. Select an icon from the Existing icons screen. 

3. Click on Delete. You are prompted to confirm the deletion. 

4. Click on Yes to confirm the deletion, or click on No to exit without deletion. 

HIDING AN ICON 

The available data connections display in the BGAN LaunchPad Data connections window. You 
can hide an icon if required using Profile Manager. 

To hide an icon: 

1. In Profile Manager, click on the Connections tab. 

2. Select an icon you want to hide, and select the Hide icon radio button. The selected icon is 
grayed out, and does not display when you open the BGAN LaunchPad Data connections 
window.  
Note: To restore the icon, repeat step 2 and deselect the Hide icon radio button. 

3. If required, repeat step 2 for any other icon you want to hide. 
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SECURITY 

ABOUT SECURITY AND CONTROL 

Using BGAN LaunchPad, you can change the SIM PIN, and enable a PIN to give a high level of 
management control over security. 

The Security and Control options are as follows: 

n Changing the SIM PIN 

n Enabling a PIN 

CHANGING THE SIM PIN AND FACILITY PASSWORD 

Using BGAN LaunchPad, you can change the SIM PIN. 

To change the SIM PIN: 

1. From the LaunchPad main menu, select Terminal > Change PINs. The Change PINs dialog 
box displays: 

 

2. Select the Change SIM PIN radio button. 

3. Enter the current pin in the Existing Pin/Password text box. 

4. Enter the new pin in the New Pin/Password text box, then re-enter the new pin in the Confirm 
Pin/Password text box. 

5. Click on Ok to save the changes, or Cancel to exit without saving. 
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CHANGING THE FACILITY PASSWORD 

You can set a password for selected phone facilities, such as all incoming calls or all outgoing 
calls. 

ENABLING A PIN 

Using BGAN LaunchPad you can enable or disable a configured PIN. 

To enable a PIN: 

1. From Launch Pad main menu, select Terminal > Require PINs. The Require PIN dialog box 
displays: 

  

2. From the Select PIN drop-down list, select the facility for which you want to enable or disable 
the PIN. 

3. Click on the Enable radio button to enable the PIN, or click on the Disable radio button to 
disable the PIN. Before you can disable the PIN, you must enter the current PIN in the Enable 
PIN text box. 

4. Click on OK to save the changes and exit, or click on Cancel to exit without saving the 
changes. 
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SOFTWARE UPGRADE 
BGAN LaunchPad can check for software updates for the LaunchPad, terminal and other 
software. It can check for these updates using the BGAN system or a terrestrial connection, and 
be scheduled to check for updates daily, weekly or monthly.  

BGAN LaunchPad can also install the appropriate software to the terminal or computer. 

CHECKING FOR UPDATES 

You can set the types of upgrade you want BGAN LaunchPad to check for, and how to check. 

1. From BGAN LaunchPad main menu, select Update > Check for Updates. The Check for 
Updates screen is then displayed: 

  

2. From the Check drop-down list, select how often you want BGAN LaunchPad to check for 
updates. The options are Daily, Weekly or Monthly. Alternatively, click on Check for updates 
now. 

3. In the Check for update to: section, choose which software types you want to check for. For 
example, if you do not want to check for updates to third party software, uncheck the Other 
3rd party software and drivers check box. By default, BGAN LaunchPad checks for all 
software upgrades. 

4. Click Apply to save the settings, or Cancel to exit without saving. 
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SOFTWARE VERSIONS AND AVAILABILITY 

You can install the software upgrades that LaunchPad has found.  

1. From BGAN LaunchPad main menu, select Update > Check for Updates . Then click on 
Check for updates now.  The following screen is then displayed: 

 

 

 

2. Review which software you want to install on the terminal or on your computer.  

3. Then click on Download now to begin the installation. 

4. LaunchPad will inform you when the download has completed. 

Note: Make sure that a loss of power will not interrupt the download process. You should install 
the terminal’s battery and fully charge it, in case there is a power outage; and connect the AC 
or DC power adapter in case the battery runs flat during the download. Similarly, if your 
computer is operating from a battery, make sure the battery is charged and connect the 
computer’s AC power adapter or charger. 
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LOG FILES 
BGAN LaunchPad maintains log files that detail the commands sent to the terminal, and the 
responses obtained from the terminal. BGAN LaunchPad also records any unsolicited events 
reported by the terminal. LaunchPad maintains three types of log file: 

n Event log file – reports details of all command and responses exchanged between BGAN 
LaunchPad and the Terminal. 

n Network log file – reports network activity-related information, such as network usage, QoS 
information, and unsolicited alerts reported by the network. 

n Terminal log file – generated by the terminal, and can be accessed from LaunchPad. 

You can do the following for any of these log files: 

n Delete or Clear a Log File. 

n Display a Log File. 

n E-mail a Log File. 

n Print a Log File. 

n Save a Log File. 
 

In addition, for event logs and network logs you can: 

n Turn Logging On and Off. 

DELETING OR CLEARING LOG FILES 

You can delete an event log file or a network log file, and clear a terminal log file from BGAN 
LaunchPad main menu.  

To delete an event or network log file from your computer, do the following from BGAN 
LaunchPad main menu: 

1. Select File > Event Log File or Network Log File. The Event Log dialog box is shown below: 

 

2. Select a log file from the drop-down list.  

3. Click on Delete. The log file is deleted from your computer. 
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To clear a BGAN log file from your computer, do the following from BGAN LaunchPad main 
menu: 

1. Select File > Terminal Log File. The BGAN Terminal Log File Management dialog box displays, 
as shown below: 

 

2. Select a log file from the Select BGAN terminal log file drop-down list. 

3. Click on Clear. The log file is cleared from your computer. 

DISPLAYING LOG FILES 

You can display the event log file, the network log file or the BGAN log file from BGAN 
LaunchPad main menu.  

To display any of these files, do the following from BGAN LaunchPad main menu: 

1. Select File > Event or Network or BGAN Log File. The Event Log dialog box is shown below: 
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The BGAN Terminal Logging dialog box is slightly different to the network or event log box, and 
gives a choice to: 

§ display all the lines in the log file, check the Retrieve all lines of log file check box.  

Or, 

§ display selected lines in the log file, uncheck Retrieve all lines of log file check box, and 
enter the number of lines you want to retrieve in the Number of lines to retrieve from 
BGAN terminal  text box. 

 

2. Click on Display to see the contents of the file you selected. 

3. Clock the Turn l ogging on/off box to turn logging on or off. 

4. Click OK to save the change. 

EMAILING LOG FILES 

You can email the event, network or BGAN log files from BGAN LaunchPad main menu.  

1. Select File > Event or Network or BGAN Terminal Log File. A dialog box displays, as shown 
below: 
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2. Select the file to email from the drop down list. 

3. Click on E-Mail to open a new message in your Email application, addressed to your support 
contact and with the log file attached. You can type in a message, if required. 

4. Select the file to email from the drop down list. 

5. Click on E-Mail to open a new message in your Email application, addressed to your support 
contact and with the log file attached. You can type in a message, if required. 

PRINTING LOG FILES 

You can print an event, network or BGAN log file from BGAN LaunchPad main menu.  

1. Select File > Event or Network or BGAN Terminal Log File. A dialog box displays, as shown 
below: 

 

2. Select a log file from the drop-down list.  

3. Click on Print to open your operating system's print dialog box, and print the log file. 
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SAVING LOG FILES TO DISK 

You can save an event, a network, or BGAN log file to a file on your computer from BGAN 
LaunchPad main menu.  

1. Select File > Event or Network or BGAN Terminal Log File. A dialog box displays, as shown 
below: 

 

2. Select a log file from the Select event log file drop-down list.  

3. Click on Save. The directory folder for your operating system opens.  

4. Navigate through to the required directory, and save the log file under the selected name. 

TURNING LOGGING ON AND OFF 

1. Select File > Event or Network or BGAN Terminal Log File. A dialog box displays. 

2. Click the Turn l ogging on/off box to turn logging on or off. 

3. Click OK to save the change. 
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 POWER-ON SELF-TEST 
 

SATELLITE TERMINAL BOOT BEHAVIOR 
When the terminal is powered up, it goes through a two-phase boot process. The first phase 
loads a Minimum Boot ROM (MBR) module, which provides basic functionality, including self-test 
and basic network connectivity. 

When the self-test has completed with no failures detected, the MBR then proceeds to the 
second phase, and loads the application module. This provides full terminal functionality. 

If the applications module is not installed or is bad, a new application has to be installed. A bad 
application could cause the terminal to stall in the second phase, or constantly reset. To prevent 
this, the boot process can be stopped at the MBR phase, so that a new application can be 
installed. This is achieved by holding down the audio button at the same time as the power 
button is pressed. 

If the audio button is accidentally pressed during power up, causing the boot process to stop at 
the MBR phase, then simply power cycle the terminal. It will power-up through both phases of 
the boot process. 

If the terminal MBR module detects a failure during the self-test, it will stop the boot process and 
indicate the source of the failure through the 6 LEDs used for pointing, as follow: 

 

Pointing LED Color and Status 

G Solid green LED 

R Solid red LED 

B Blank or off LED 

BG Blinking green LED 

BR Blinking red LED 

 

1 2 3 4 5 6 Description of Failure Action 

R B B B B B The main processor has failed to start Note 1 

G BR BR B B B The main processor has detected a fault in its 
memory 

Note 1 

G BR BG BR B B The terminal SW is not properly installed Note 2 

G BR BG BG BR B The terminal SW is not properly installed Note 2 

G G BR BR B B The main processor has detected a fault in the 
Ethernet interface 

Note 1 

G G BR BG BR B The main processor has detected a fault in the 
USB interface 

Note 1 

G G BR BG BG BR The main processor has detected a fault on the Note 1 
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1 2 3 4 5 6 Description of Failure Action 

WLAN interface 

G G G BR B B The main processor has detected a fault in the 
ASIC   

Note 1 

G G G BR BG BR The main processor has detected a fault in the 
transmitter 

Note 1 

G G G BR BR BG The secondary processor has detected a fault in 
its memory 

Note 1 

G G G BG BR BR The secondary processor has failed to start Note 1 

 

Note 1:  Remove all data cables and power cables from the terminal (remember to remove the 
battery). Wait 30 seconds, then reconnect power and re-start the terminal. If this does not clear 
the failure, follow the troubleshooting procedures below. 

Note2:  Re-load the terminal’s SW using the BGAN LaunchPad. 

 

TROUBLE SHOOTING BOOT MODE PROBLEMS 

If a SW upgrade fails, the UT will come up in boot mode and the LEDs will be lit up as indicated in 
the above chart. A known problem in this mode is that the DHCP server does not work. If the 
communication to the UT can not be established, then you have to manually configure the IP 
address of the connected PC by going to your Network Connection icon and right click and 
select “Properties”. The following screen shot shows your Network Connections. You need to 
select the connection that is tied to your Ethernet card (e.g. Local Area Connection 4). Right 
click on the LAN connection (maybe named differently) and select “Properties”. 
 

 
 
The following screen appears. Scroll down until you find the Internet Protocol (TCP/IP) and then 
click on “Properties”. 
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The following screen appears: 
Click on the radio button that says “Use the following IP address” 
 
The static IP address information below should be entered: 
IP Address: 192.168.128.101 
Subnet Mask:  255.255.255.0 
Default GW: 192.168.128.100 
 
Click on OK to confirm the entries.. 
 

 
 
To verify the connection to the terminal, open a DOS command window and at the DOS prompt 
try pinging the UT by typing “ping 192.168.128.100”. If you get 4 replies back, you know you have 
connectivity to the UT. 
 
Once you have connectivity to the UT, then you can use the Hughes Upgrader to load the latest 
software into the UT. You can download the latest Upgrader and software from the Hughes 
website by using the following link: 
http://bgan.hughes.com 
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Instructions to use the BGAN software upgrader for the Hughes 9201 
 

1. Run the ZIP file, which will unpack the BGAN upgrader into the c:\BGAN_Upgrader_a.b.c.d 
folder on your computer. Note that a.b.c.d is the version of software that the upgrader will 
load onto your Hughes 9201 satellite terminal. 

2. Connect the Ethernet port of the BGAN modem to be upgraded to the LAN port of the PC 
using a standard Ethernet cable. Insert a SIM card into the BGAN modem. 

3. Connect an AC/DC converter (supplied in the BGAN install kit) to the BGAN modem, if it 
does not power on automatically, press the power button to turn it on. 

4. Run BGANUpgrader.exe file in the above folder 

5. On the BGAN Upgrader Window, click the "Upgrade" button  

6. During the Upgrade process, it is imperative that the power supply and Ethernet connections 
to the BGAN modem are not removed or interrupted. 

7. The status and progress of the Upgrade is shown in the BGAN Upgrader window. 

8. If a SIM card is not present, an error window will pop-up asking to check that a SIM card is 
present. You will then need to go back to step 2.  

 
If a SIM card is present, the Upgrader will show a pop-up window with the DNS server addresses. 
You can change one or both of these addresses and click on "modify" to save the change, or 
click on "keep current" if you do not want to change the addresses. 
 

9. The upgrade process will proceed. After about 2 minutes, a window will pop-up stating: 
"Upgrade Complete”. Click OK and wait until the new Software version is indicated. 

10. Click OK 

11. After about 30 seconds, the following message will appear in the window: "Software version 
was retrieved!" 

12. The terminal has been successfully upgraded, and the power and Ethernet connections can 
be removed. 

13. If you want to upgrade another terminal, there is no need to close the BGAN Upgrader 
window. Just repeat steps 2 through 12, but omit step 4. 
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The following functions are also available from the pull-down menu items in the Upgrader 
program: 
 
File-> 
• Upgrade: upgrade modem software (same function as 5 above) 
• Restore: restores the terminal software back to the version prior to the upgrade 
• PICupgrade: upgrades only the PIC software, not the main modem software. The PIC 

software is normally not part of the software release, so it is normally not upgraded at the 
same time as the modem software. If the upgrader includes PIC software, then it will be 
automatically upgraded. 

• Disable Auto PIC upgrade: disables the upgrader from automatically upgrading the PIC 
software if it is included with the upgrader. 

 
Tools-> 
• Get SW version: reads the software version loaded on your modem, and the version that is 

available to be upgraded  
• Set DNS addresses: read and change the DNS server addresses (same function as 8 above). 
• Reset Modem: turns the modem off and back on. 
 
Help-> 
• About upgrades: shows the version number of the upgrader. 

 

Note: You can also use the Diagnostic Report function under the LaunchPad Help pull down 
window to validate that the download was successful. 
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 TROUBLE SHOOTING 
 

Problem Possible Cause Possible Solution 

Terminal will not turn on Power button not pressed for long 
enough  

Discharged battery 
 

Battery not fitted 

Press the button for 2 seconds 
 

Connect the AC or DC power 
adapter 

Connect the AC or DC power 
adapter 

Battery does not charge Battery is defective (battery LED is 
flashing red) 

Battery temperature is outside charging 
range 

Replace battery 
 

Battery will only be charged at 
temperatures between 0°C and 
45°C.  

Cannot insert battery 
into terminal 

Battery incorrectly oriented Ensure the battery is oriented as 
shown in First Time Setup 

Cannot insert USIM card 
holder into terminal 

USIM is not correctly seated in the card 
holder 

Card holder incorrectly oriented 

Ensure the USIM is pressed firmly 
into the card holder 

Ensure the card holder is 
oriented as shown in First Time 
Setup 

Cannot lock the 
terminal’s stand at the 
desired protractor angle 

Lock knobs are not tight enough Ensure lock knobs are turned in 
the direction shown on the 
knobs. Both knobs will gradually 
tighten if you push the unit to a 
lower angle. This can help with 
locking the unit when the 
desired protractor angle is close 
to 90 degrees.  

Terminal’s lock knobs 
cannot be loosened 

Closing the stand has tightened both 
lock knobs 

Open the terminal’s stand, this 
will automatically loosen the lock 
knobs. 

The Terminal tips 
forward. 

The stabilizer has not been deployed See Terminal Stand Positioning 

In a fixed installation, the 
terminal will not turn on 
and  reconnect to the 
BGAN system after a 
power outage 

Terminal’s automatic modes are not set 
correctly 

Set the automatic modes, see 
Automatic Mode 
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Problem Possible Cause Possible Solution 

The BGAN LaunchPad 
will not connect to the 
terminal 

No interface connection between the 
terminal and computer 
 
 
 
Terminal is in Boot Mode 

Ensure there is a WLAN, Ethernet 
or USB connection between the 
terminal and computer, see 
Connecting the Terminal to the 
Computer 

Follow the instructions in 
Troubleshooting Bootmode 
Problems to recover the terminal 
from Boot Mode. 

The BGAN LaunchPad 
will not connect to the 
terminal over the WLAN 
interface 

WLAN WEP is enabled on terminal and 
the computer’s WLAN  is not 
programmed with the WEP key. 
 
 

 
WLAN signal is not strong enough 

Disable WEP, or use the same 
WEP keys for both the terminal 
and computer. For details, go to 
Connecting Terminal to PC and 
other devices via WLAN 
interface 

Locate the terminal and 
computer to reduce any 
obstructions between them, and 
locate them closer together. 

 

Terminal will not accept 
incoming ISDN calls 

The MSN programmed into the ISDN 
device does not match the MSN 
programmed into the terminal 

Ensure the appropriate MSN is 
programmed into the ISDN 
device, see Voice Telephony 
Services and ISDN Data 

Ensure the appropriate MSN is 
programmed into the terminal, 
see ISDN Equipment 

Terminal will not make 
outgoing ISDN calls 

The ISDN interface is turned off (Note 
the interface turns off automatically 
when the terminal is operating from 
battery power, if no ISDN device is 
detected within 5 minutes from power 
on) 

 

Terminal is still in antenna pointing mode 

Enable the ISDN interface from 
the BGAN LaunchPad, see ISDN 
Equipment  

Alternatively, turn the terminal 
off, then turn it on and 
immediately connect the ISDN 
device 

Exit antenna pointing 
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Problem Possible Cause Possible Solution 

Terminal is connected to 
the BGAN network, but 
cannot obtain the 
requested Quality of 
Service 

The terminal is not optimally pointed at 
the satellite 

Re-point the terminal, see 
Pointing the Terminal.  

Ensure the following minimum 
LEDs are lit for the requested 
Quality of Service: 

Streaming 256: all LEDs green 

Streaming 128: 3 green + 1 red 
LED 

Streaming 64: 2 green + 1 red 
LED 

Streaming 32: 1 green + 1 red 
LED 

background or standard: 1 red 
LED 

ISDN data (64Kbps): 2 green + 1 
red LED 

CS voice (4): 1 red LED 

 

Terminal does not obtain 
a GPS fix 

Terminal’s location limits visibility of 4 or 
more GPS satellites. 

See Field Service Bulletin FSB0306-01.pdf 
for instructions on tightening chassis 
screws around GPS antenna area. 

Move the terminal to a location 
where there are few obstructions 
such as trees or tall buildings, so 
that as much as possible of the 
sky is visible; see Obtaining a GPS 
fix 

You hear a continuous 
beep from the terminal 
when you connect an 
ISDN device to the ISDN 
port 

The ISDN device is trying to draw too 
much power from the satellite terminal’s 
ISDN interface 
 

 

The device you are connecting is not an 
ISDN device. It might be an Ethernet 
device that you are accidentally 
connecting to the ISDN port. 

Only connect an ISDN device 
that draws less than 70mA of 
current at 40V (equivalent 
power 2.8W) 

 

Make sure you connect only 
ISDN devices to the ISDN port 

None of the above 
solutions resolve the 
problem 

Terminal may have a hardware or 
software fault, and needs to be re-
booted. 

Remove the power adapter, 
and battery. Wait 30 seconds. 
Reconnect the AC or DC power 
adapter or the battery, and turn 
on the terminal. 

As the terminal powers up, 
check the status of the LEDs, see 
Satellite Terminal Boot Behavior  
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 TECHNOLOGY OVERVIEW 
 

GPS 
The Global Positioning System (GPS) uses 24 orbital satellites to determine the position of the 
Terminal anywhere on the globe.  

OBTAINING A GPS FIX 

In normal operation, a GPS receiver, such as that built in to the Terminal, needs to be able to 
receive signals from at least four satellites so that it can then calculate a latitude, a longitude 
and an altitude – this position fix is referred to as a 3-dimensional or 3-D fix. If only three GPS 
satellites can be seen by the GPS receiver, then the last available altitude measurement is 
assumed and the GPS receiver calculates a position fix based on latitude and longitude only. 
This simpler position fix is referred to as a 2-dimensional or 2-D fix and is quicker and easier to 
obtain than a 3-D fix, but may be less accurate. 

The GPS receiver may take between a few seconds and 20 minutes to obtain a GPS fix, 
depending on how frequently the GPS receiver is being used. The frequency of use determines 
the how quickly the GPS Terminal is able to start. 

n Hot start − if the GPS receiver is being used frequently, (that is, in the last two hours), it is 
regularly updated with data from the GPS satellites, and so only takes a few seconds to 
obtain a GPS fix after being switched on. 

n Warm start − if a GPS receiver has not been used for more than two hours, then it will take up 
to 45 seconds to obtain a GPS fix.  

n Cold start − if the GPS receiver has not been used for some time or is 300 km or more from 
where it was last used, it can take as long as 15 minutes to obtain a valid position fix.  

The time taken to obtain a valid GPS fix can also be affected by the visibility that the GPS 
receiver has of the GPS satellites. The GPS system is relatively tolerant of atmospheric conditions 
such as heavy cloud or rainfall. However, physical blockages, such as tall buildings or terrain can 
significantly degrade the ability of the GPS receiver to obtain a fix. For this reason, ensure that 
the GPS receiver has a clear view of as much open sky as possible. 

GPS AND BGAN REGISTRATION 

BGAN uses the accurate position and timing information obtained from GPS to help ensure 
efficient registration of a BGAN Terminal with the BGAN network.  

Following successful registration and providing the Terminal is left switched on and remains 
stationary, the GPS is no longer needed. Periodically, the BGAN Terminal contacts the BGAN 
network to inform the network that it is still switched on. In addition, the BGAN network 
periodically checks each Terminal for activity, and if the Terminal has not automatically 
contacted the BGAN network as described above, then the Terminal will be de-registered from 
the network. 
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ISDN 
The Satellite Terminal provides an ISDN (Integrated Services Digital Network) interface to connect 
devices for Circuit Switched voice and data services. It is a Basic Rate (also known as 2B+D) 
interface and uses the Euro ISDN protocol. Note that the Satellite Terminal can only provide 
service for one 64Kbps B-channel at a time. 

DIALING AND NUMBERING 

DIALING 

As the ISDN numbering system follows the same pattern as the normal telephone system, dialing 
is carried out in exactly the same manner as making a normal telephone call. The subscriber 
number is used with the same international and area codes as any other telephone network. 

MULTI-SUBSCRIBER NUMBERING (MSN) 

ISDN supports Multi-Subscriber Numbering (MSN). MSN is a facility whereby more than one 
telephone number can be allocated to an ISDN line. The BGAN Satellite Terminal assigns 
different MSNs for Voice, 3.1KHz Audio, UDI and RDI devices. Each incoming call will be directed 
to the appropriate MSN depending on the type of call. This allows to route incoming calls to the 
correct ISDN device (e.g. ISDN phone, data card or Fax). 

 

PDP CONTEXT 
A Packet Data Protocol (PDP) Context defines connection aspects such as routing, Quality of 
Service (QoS), security and billing between a mobile user terminal, such as the BGAN Terminal, 
and a data network. PDP Contexts are essential to the General Packet Radio Service (GPRS) 
system, which is used by GSM and UMTS-based 3G networks worldwide for transmitting data.  

In order for a user to be able to transfer data across a network, a PDP Context must be 
activated in the Terminal and associated Core Network. The procedure for this is as follows: 

1. After registration with the network, the user activates a PDP Context using an application on 
the computer or Terminal, and requests sufficient radio resources (that is, power and 
bandwidth) to support the context activation procedure. 

2. Once the resources are allocated, the Terminal sends the Activate PDP Context request to 
the Core Network. This request includes key information about the mobile user's PDP address 
(for example an IP address), PDP type (that is, static or dynamic address) the QoS requested 
for this context, the APN of the external network to which connectivity is requested, the user's 
identity (IMSI) and any necessary IP configuration parameters (for example, security settings). 

3. On receiving the Activate PDP Context message, the Core Network checks the user's 
subscription record to establish whether the request is valid. If the request is valid, a virtual 
connection is established between the Terminal and the Core Network, and data transfer 
can then take place between the Terminal and the external data network, within the scope 
of the current PDP Context. The PDP Context is stored in both the Terminal and the Core 
Network. 

A single Terminal may have multiple PDP Contexts each with different QoS profiles. The primary 
PDP Context is a PDP Context with default QoS profile attributes and is always activated first. All 
other PDP Contexts with the same PDP Address are secondary PDP Contexts. Secondary PDP 
Contexts share the same PDP Address and connect to the same APN but may have different 
QoS profiles. 
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WLAN 
Wireless Local Area Networking (WLAN) enables two or more computers equipped with wireless 
adapter cards to share resources. 

A wireless network comprises of two or more computers each equipped with wireless adapter 
cards forming a network. When the computers are within range of each other each computer 
has access only to the resources of the other computer but not to any central server or other 
resource. This type of basic configuration is known as an ad hoc network. 

A more common and efficient use of a wireless network is one in which two or more computers 
equipped with wireless adapter cards are linked to a WLAN Access Point. The Access Point 
allows each computer to have access to shared resources, such as a broadband Internet 
connection, as well as to other computers on the network. Such a configuration is know as 
Infrastructure Mode. This is the default configuration for WLAN in the UT. 

PERFORMANCE 

The performance of a WLAN network will be influenced by several factors including the number 
of users on the network, the location of the antenna, the distance from the antenna and the 
degree of blocking from buildings and other infrastructure. Typical operating ranges are 200-300 
meters outdoors and 30-60 meters indoors, the performance degrades gradually as the signal 
strength decreases. 

SSID 

A wireless network is identified by a Service Set Identifier or SSID. An SSID is also referred to as a 
Network Name because it is a name that identifies a wireless network. Wireless devices that wish 
to communicate with each other must be configured with the same SSID. Several Access Points 
can be set up using the same SSID so that users can roam from one Access Point to the other 
without losing network access. The SSID is broadcast so that any wireless device in range can 
read the SSID and ask permission to associate with it. The SSID is not intended as a security 
measure − it is used only to identify different networks. 
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 TECHNICAL SPECIFICATIONS 
 

Weight 2.8 Kg (terminal with battery) 

Dimensions 27.5 cm  x 34.5 cm x 5.0 cm 

Battery Life 

(actual performance 
based on range of 
factors and actual 
usage) 

Transmit:  162 Mbits 

Receive:  864 Mbits 

36 hours standby time 

(standard battery) 

Humidity 95% RH at +40°C 

Temperature -25°C to +60°C operating 

-25°C to +80°C storage 

Water & Dust IP-55 standard 

Transmitter power 20dBW EIRP maximum 

Antenna 
characteristics 

Nominal gain 15dBi, nominal 3dB beamwidth ±20 degrees. 

The Satellite Terminal carries a warranty for 12 months from the date of sale. Contact you Service 
Provider if you have questions about the warranty, or need to return the terminal for repair. 
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 DECLARATION OF CONFORMITY 
Hughes Network Systems, LLC, of 9605 Scranton Road, San Diego, CA, 92121, USA, declares 
under our sole responsibility that the product Hughes 9201 Satellite IP Terminal to which this 
declaration relates, is in conformity with the following standards and/or other normative 
documents: 

ETSI EN 301 444 , ETSI EN 300 328, ETSI EN 301 489-1, ETSI EN 301 489-17, ETSI EN 301 489-20, IEC 
60950-1, Council Recommendation 1999/519/EC. 

We hereby declare that all essential radio test suites have been carried out and that the above 
named product is in conformity to all the essential requirements of R&TTE Directive 1999/5/EC. 

The conformity assessment procedure referred to in Article 10 and detailed in Annex [III] or [IV] of 
Directive 1999/5/EC has been followed with the involvement of the following Notified Body(ies):  

BABT, Balfour House, Churchfield Road, Walton-on-Thames, KT12 2TD, UK. 

Identification mark: 0168 (Notified Body number). 

The technical documentation relevant to the above equipment will be held at: 

Hughes Network Systems, LLC, 9605 Scranton Road, San Diego, CA, 92121, USA 

Signed by Peter Sroka (Senior Technical Director, August 12, 2005) and Bill Lindsay (Senior 
Program Manager, August 12, 2005). 

 

EU WEEE (WASTE ELECTRICAL AND ELECTRONIC EQUIPMENT) DIRECTIVES  
 

The European Union (EU) directive on waste electrical and electronic equipment mandates 
recycling of electrical and electronic equipment throughout the EU by August 13, 2005. 

Unless otherwise noted, all products, assemblies, and sub-assemblies manufactured by Hughes 
and its sub-contractors will be compliant with this directive and any subsequent revisions or 
amendments. This product carries the WEEE label below to demonstrate compliance. 

For addition information, contact Hughes Network Systems at: www.hughes.com. 
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 GLOSSARY 
 

APN: An Access Point Name (APN) provides access to an external network. By default, the SIM 
Card in your terminal is configured with the APN of your Internet Service Provider. You may 
want to configure further APNs if you have arranged with your Service Provider to use more 
than one SIM Card.  

BGAN Satellite Terminal: Referenced throughout this document as the Satellite Terminal, “The 
Terminal” or the UT (User Terminal)”, this device implements and manages BGAN satellite 
communications between your computer and your Service Provider’s network.  

Quality of Service: Quality of Service (QoS) assigns a level of priority to certain types of data 
traffic, in particular high bandwidth applications such as video and multimedia. QoS 
attempts to maintain a guaranteed throughput level, and minimize error rates and end to 
end latency, so providing a higher level of service than "best effort" protocols.  

DNS Server: The Domain Name System (DNS) is an Internet service that is required because the 
Internet does not recognize the text-based Web address or email address that you type into 
your Web browser or email application. All or part of a Web address or an email address is a 
domain name, and DNS translates this domain name into an IP address that is recognized by 
the Internet. 

A DNS Server holds a database of domain names and IP addresses, so that when you enter 
a Web address or email address, you are directed to the correct IP address over the Internet. 

Dynamic DNS Server : If you are using dynamic IP addressing, Inmarsat recommends that you 
use a dynamic DNS server. A dynamic DNS server updates the IP address information in 
the DNS database each time your IP address changes. A dynamic DNS server also 
enables a computer using a dynamic IP address to use network applications that 
normally require a static IP address, for example FTP servers. This service requires 
subscription with a Dynamic DNS provider. 

Static DNS Server : If you are using static IP addressing, Inmarsat recommends that you use a 
static DNS server. If you select this option, you must enter the IP address of the Primary 
DNS Server. This is supplied by your Internet Service Provider. Optionally, you can enter 
the IP address of a Secondary DNS Server, also supplied by your ISP. This is used in the 
event of failure of the Primary DNS Server. 

Error correction : Error correction ensures that very little data is lost during transfer by asking for 
dropped packets to be resent. However, because it holds subsequent data whilst the 
packet is being resent, you may notice some jitter or delay in the received data. This is 
normal for most data types.  

 For real-time applications, such as Voice over IP (VoIP) or video, it is recommended that you 
remove error correction. Removing error correction minimizes delay and jitter.. 

Ethernet: Ethernet is a local area networking method used widely throughout the computer 
industry. It is one of the three communications interfaces supported by the Satellite Terminal. 

Fault Code: A number which uniquely references an error in a hardware or software system. In 
the Satellite Terminal, if there is a fault detected, the fault code and a description are 
displayed in suitable LaunchPad windows. 

GPS: Global Positioning System. The GPS receiver in the Satellite Terminal receives signals from 
the constellation of GPS satellites. It uses these signals to determine the Terminal’s location on 
earth. That location is used during registration to gain access to the BGAN system. 

Header Compression : A header is the component of a data packet that precedes the data that 
you are sending. The header contains information such as source and destination address, 
error checking and other administrative details. In most data types this does not noticeably 
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affect the data transmission rates. However in multimedia applications such as voice and 
video, the header can significantly affect performance. 

Inmarsat recommends that you switch on header compression for multimedia applications, 
such as video. 

IP Address: An Internet Protocol address, or IP address, is a number that identifies the computer 
that is sending or receiving information transmitted over the Internet. An IP address is made 
up of four groups of numbers between 0 and 255, separated by periods. For example, 
207.115.79.4 is an IP address. In the BGAN system, IP addresses can be dynamic or static. 

Dynamic IP Address: A dynamic IP address is a temporary address that is assigned by your 
Internet Service Provider (ISP) when you connect to the Internet. If you do not need a 
permanent IP address, Inmarsat recommends that you obtain a dynamic IP address. 
Normally, individual users of the Internet use a dynamic IP address. 

Static IP Address: A static IP address is assigned permanently, and is used every time you 
connect to the Internet. Normally, companies and other organizations that have their 
own networks use static IP addresses. 

MSN: Mobile Subscriber Number, for ISDN call types.  

PDP: Packet Data Protocol.  

SIM Card: Your Service Provider supplies you with a Subscriber Identification Module (SIM) Card 
or a Universal Mobile Telecommunications System Subscriber SIM (USIM) Card.  

A SIM or USIM Card is a card commonly used in a GSM phone. The card holds a microchip 
that stores information and encrypts voice and data transmissions, making it extremely 
difficult to listen in on calls. The USIM Card also stores data that identifies the caller to the 
Service Provider. 

Standard Connection: A standard connection is charged by volume of data sent. The 
bandwidth you are allocated depends on terminal type and network availability, but is 
always ‘best effort’, that is, you are allocated bandwidth depending on your requirements 
and the requirements of other users of the BGAN network, or BGAN Terminal. This connection 
class is suitable for most data types, other than multimedia. 

Streaming: A streaming connection is charged by time. You are charged for the amount of time 
the connection is active. Streaming enables multimedia data, such as video, to be sent in a 
continuous data stream and converted into sound and pictures. The bandwidth required for 
a streaming connection is difficult to predict, and depends on factors such as length of 
connection and number of receivers.  

Symmetrical Rate: The rate at which streaming data is transmitted, in kilobits per second (Kbps). 
This rate applies to transmitted (uplink) and received (downlink) data. 

Desired Symmetrical Rate: From the drop-down list, choose the desired data rate for your 
Streaming connection. This can be 32 Kbps, 64 Kbps, 128 Kbps or 256 Kbps. This figure is 
guaranteed, unless the connection cannot meet this requirement because of bandwidth 
restrictions. In this case the rate defaults to the minimum symmetrical rate. 

Minimum Symmetrical Rate: From the drop-down list, choose the minimum data rate that 
you are prepared to accept for your Streaming connection. This can be 32 Kbps, 64 
Kbps, 128 Kbps or 256 Kbps. This rate must be lower than the Desired Symmetrical Rate. If 
the connection cannot meet this requirement, an error message displays. 

TE: Terminal Equipment, e.g. your computer or ISDN phone. 

Traffic Flow Template: A Traffic Flow Template, also called an Application Template, is a series of 
data filters such as QoS (Quality of Service), PDP Context and security settings, that allow the  
Core Network to classify packets received from an external network into the correct PDP 
Context.  When incoming data arrives at an access point in the core network, a packet 
classifier will make a PDP Context selection based on the Traffic Flow Template, and map the 
incoming data packets into the PDP Context with the correct QoS attributes. The use of a 
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Traffic Flow Template allows multiple PDP Contexts to be associated with the same PDP 
address. 

USIM Card: Your Service Provider supplies you with a Subscriber Identification Module (SIM) Card 
or a Universal Mobile Telecommunications System Subscriber SIM (USIM) Card.  

A SIM or USIM Card is a card commonly used in a GSM phone. The card holds a microchip 
that stores information and encrypts voice and data transmissions, making it extremely 
difficult to listen in on calls. The USIM Card also stores data that identifies the caller to the 
Service Provider. 

UT: User Terminal; BGAN Satellite Terminal. 

Virtual Private Network: A Virtual Private Network (VPN) enables remote offices or users to gain 
secure access to their organization's network over the public telecommunications network. 
This provides the benefits of remote access without the expense of dedicated leased or 
owned lines. VPNs work by using tunneling protocols, such as L2TP, to encrypt data at the 
sending end, and decrypt the data at the receiving end. This "tunnel" cannot be accessed 
by data that is not properly encrypted.  

 


